User Guide & Techniques

By MechaTools Technologies
3030, Louvigny
Quebec (QC)
G1W 1B1, Canada
Tel.: (418) 265.5171
www.mechatools.com/en/support.html
www.mechatools.com
LICENSE AGREEMENT

ShapeDesigner(TM) SOFTWARE-as-a-service Subscription agreement


Software-as-a Service (SaaS) Terms of Use

- Subject to the terms and conditions of this Agreement, MechaTools agrees to provide to User, on a Software-as-a-Service (SaaS) basis in exchange of Subscription Fees, the ShapeDesigner™ software (including the SaaS protocol access and SaaS application), its interface, database, and the documentation that accompanies it (collectively the “Software”), identified, described and available online, and delivered on the Activation Date hereof. By installing the Software on his computer, the User becomes a registered user of the Software, which MechaTools provides for the exclusive use of each registered user.
- If the User is agreeing to this Agreement on behalf of a company or other legal entity, User represents that it has the authority to bind such entity to this Agreement.
- User acknowledges and agrees that MechaTools may modify the terms and conditions of this Agreement at any time without notice to User by posting revised terms or Agreement on SaaS Site. User’s use of the Software and of this SaaS Site constitutes its binding acceptance of this Agreement, including any modifications that MechaTools makes. User is responsible for regularly reviewing this Agreement and the terms and conditions it contains.
- Copy of the Software may be used:
  i. In the case of an unlimited license: by multiple people non-simultaneously on a single computer,
  ii. In the case of a floating license: by multiple people non-simultaneously on any computer on the network where the network is identified by the static IP address connecting to our servers.
  iii. In the case of a limited license: by a multiple people simultaneously on any computer.
- User may access the Software through a network, provided that User has the license right to use the software as defined by the unlimited, floating and limited license types.
If the Software is provided as an upgrade, patch or update to an earlier licensed release of the Software, then User must have a valid license to use such earlier release of the same version as the upgrade to install or use the upgrade. All Software being upgraded is deemed to be part of the Software and is subject to this Agreement.

License Grant

MechaTools hereby grants to User, by means of User’s account and authorized password, subject to all of the terms and conditions of this Agreement, a non-exclusive, non-transferable license for access to the Software via the Internet and to use the Software, in object code form only, solely for business purposes in accordance with the terms set out in this Agreement.

User shall not, directly or indirectly:

1. reverse engineer, decompile, disassemble, modify, translate, make any attempt to discover the source code of the Software or underlying ideas or algorithms of the Software, or create derivative works from the Software, copy or recreate any component of the Software and delivery media;
2. copy, sublicense, sell, rent, lease, distribute, or otherwise transfer rights to the Software or any portion of the Software;
3. remove, delete or modify any copyright notices or any other proprietary notices or legends on, in or from the Software;
4. use the Software in any manner that could damage, disable, overburden, or impair MechaTools’ or any other party’s search services, servers, or other services; or
5. use the Software in any manner not authorized by this agreement.

Copyright and Intellectual Property Rights

User hereby acknowledges that the Software is the exclusive property of MechaTools Technologies Inc. and is protected by copyright law and patent law. MechaTools is the sole owner of the Software and, except as expressly set forth herein, shall retain any and all rights, titles and interests in the Software. No title to the intellectual property in the Software is transferred to the User. This agreement governs any releases, revisions, or enhancements to the Software that MechaTools may furnish to the User.

DISCLAIMER OF WARRANTIES

MechaTools Studio™, ShapeDesigner™, STDShapeLib™, GenShapeLib™ are proprietary computer program of MechaTools Technologies. MechaTools Technologies does not accept responsibility for any mistake, error or misrepresentation in, or as a result of, the usage of these programs and their documentations. The author of this program and documentation are not responsible to user for loss or damage caused, directly or indirectly by the software and its attendant documentation.

Any technical documentation that is made by MechaTools Technologies is the copyrighted work of MechaTools Technologies Inc and is owned by MechaTools Technologies Inc. NO WARRANTY. The technical documentation is being delivered to you AS-IS and MechaTools Technologies makes no warranty as to its accuracy or use. Any use of the technical documentation or the information contained therein is as the risk of the user. Documentation may include technical or other inaccuracies or typographical errors. MechaTools Technologies reserves the right to make changes without prior notice.

No part of this documentation may be copied without the express written permission of MechaTools Technologies, 3030, Louvigny, Quebec, Quebec - G1W 1B1 Canada.

THE USER AGREES TO USE THE SOFTWARE AT THE USER’S OWN RISK. THE USER AGREES THAT MECHATOOLS OFFERS NO WARRANTIES WHATSOEVER. ALL EXPRESS, IMPLIED, AND STATUTORY WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF INTELLECTUAL PROPRIETARY RIGHTS, ARE EXPRESSLY DISCLAIMED TO THE FULLEST EXTENT PERMITTED BY LAW. ALSO TO THE FULLEST EXTENT PERMITTED BY LAW, MECHATOOLS DISCLAIMS ANY REPRESENTATIONS, WARRANTIES, OR GUARANTIES AS TO THE QUALITY, SUITABILITY, TRUTH, ACCURACY, OR COMPLETENESS OF ANY OF THE MATERIALS CONTAINED IN THE SOFTWARE. MECHATOOLS MAKES NO WARRANTY THAT (a) THE SOFTWARE WILL MEET THE USER’S REQUIREMENTS, (b) THE SOFTWARE WILL BE ERROR-FREE, UNINTERRUPTED, TIMELY OR SECURE, (c) DEFECTS WILL BE CORRECTED, (d) RESULTS OBTAINED FROM THE USE OF THE SOFTWARE WILL BE ACCURATE OR RELIABLE, OR (e) THE QUALITY OF ANY INFORMATION OR OTHER MATERIAL OBTAINED BY THE USER THROUGH THE USE OF THE SOFTWARE WILL MEET THE USER’S EXPECTATIONS.

NO ADVICE OR INFORMATION, WHETHER ORAL OR WRITTEN, OBTAINED BY THE USER FROM MECHATOOLS WILL CREATE ANY WARRANTY NOT EXPRESSLY STATED IN THE TERMS OF THIS AGREEMENT. MECHATOOLS’S EMPLOYEES OR ANY OF MECHATOOLS’S AFFILIATES COMPANIES’ EMPLOYEES ARE NOT AUTHORIZED TO VARY THESE TERMS.

Passwords and Security

- MechaTools shall issue to User, or shall authorize a Customer User’s administrator to issue, a password for each User authorized to use Customer’s account for whom Customer has paid the applicable subscription fees. User and/or Customer’s Users are responsible for maintaining the confidentiality of all passwords and for ensuring that each password is used only by the authorized User. User and/or Customer’s administrator are entirely responsible for any and all activities that occur under their accounts. User and/or Customer’s administrator agree to immediately notify MechaTools of any unauthorized use of their accounts or any other breach of security know to them. MechaTools shall have no liability for any loss or damage arising from User’s and/or Customer’s administrator’s failure to comply with these requirements. MechaTools will maintain User’s and Customer’s User’s passwords as confidential and will not disclose them to third parties.

- MechaTools will maintain the Software at a reputable third party Internet service provider and hosting facility, where they are subject to commercially reasonable security precautions to prevent unauthorized access to the Software. User acknowledges that, notwithstanding such security precautions, use of or connection to the Internet provides the opportunity for unauthorized third parties to circumvent such precautions and illegally gain access to the Software and User Data. Accordingly, MechaTools cannot and does not guarantee the privacy, security or authenticity of any information so transmitted over the Internet.

Termination

- The original term of this Agreement is initiated from the Activation Date and will expire according to the User’s License and Fees. Upon expiration of the term of this Agreement, this Agreement will expire and MechaTools will terminate User’s ability to access and use the Software, unless User has renew its subscription or has subscribed to a new Subscription Package by that date.

- Notwithstanding the foregoing, MechaTools may immediately terminate or suspend User’s access and use of the Software, or terminate User’s account and this Agreement if User:
  - fails to pay any applicable fees when due; or
  - breaches or otherwise fails to comply with this Agreement and fails to remedy this breach within thirty (30) days of being so notified.
Termination will not relieve User from any obligation to pay fees that remain unpaid and will not limit either Party from pursuing other available remedies. Upon termination of this Agreement or any part thereof in accordance with this Agreement as a result of User’s breach, negligence or default, MechaTools will have no obligation to refund User any fees paid, if any. The provisions of this Section will not apply to those situations defined by law.

**Limitation of Liability**

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, AND REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSES, IN NO EVENT AND UNDER NO CIRCUMSTANCES SHALL MECHATOOLS BE LIABLE TO THE USER OR TO ANY THIRD PARTY FOR ANY DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL, EXEMPLARY, OR PUNITIVE DAMAGES INCLUDING ANY LOSS OF PROFITS OR DATA ARISING FROM THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF MECHATOOLS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

THE USER HAS SOLE RESPONSIBILITY TO PROVIDE FOR ADEQUATE PROTECTION AND BACKUP OF DATA AND/OR EQUIPMENT USED IN CONNECTION WITH THE SOFTWARE, AND WILL NOT MAKE A CLAIM AGAINST MECHATOOLS FOR LOST DATA, RE-RUN TIME, INACCURATE OUTPUT, WORK DELAYS, OR LOST PROFITS RESULTING FROM THE USE OF THE SOFTWARE.

BY INSTALLING AND USING THIS SOFTWARE, THE USER AGREES TO INDEMNIFY MECHATOOLS AND ITS SUBSIDIARIES, AFFILIATES, OFFICERS, AND EMPLOYEES AND HOLD THEM HARMLESS FROM ANY AND ALL CLAIMS AND EXPENSES, INCLUDING ATTORNEY’S FEES, ARISING FROM HIS USE OF THE SOFTWARE. BY USING THE SOFTWARE, THE USER HEREBY AGREES TO RELEASE MECHATOOLS AND ITS SUBSIDIARIES, AFFILIATES, OFFICERS, AND EMPLOYEES FROM ANY AND ALL CLAIMS, DEMANDS, DEBTS, OBLIGATIONS, DAMAGES (ACTUAL OR CONSEQUENTIAL), COSTS, AND EXPENSES OF ANY KIND OR NATURE WHATSOEVER, WHETHER KNOWN OR UNKNOWN, SUSPECTED OR UNSUSPECTED, DISCLOSED OR UNDISCLOSED, THAT THE USER MAY HAVE AGAINST THEM ARISING OUT OF OR IN ANY WAY RELATED TO SUCH DISPUTES AND/OR THE SOFTWARE. THE USER HEREBY AGREES TO WAIVE ALL LAWS THAT MAY LIMIT THE EFFICACY OF SUCH RELEASES.

**Trademarks**

MechaTools Studio™, ShapeDesigner™, STDShapeLib™ and GenShapeLib™ are trademarks of MechaTools Technologies.

Microsoft, Windows 7/Vista/XP/2003 are registered trademarks of Microsoft Corporation.

Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies and are hereby acknowledged.
This manual describes ShapeDesigner™, a section properties calculation, stress analysis and design tool. ShapeDesigner™ can work with any finite elements and structural analysis software. ShapeDesigner™ is a stand-alone application with many advanced engineering functionalities. It can also be integrated in any commercial structural and finite elements software.

This manual is divided in seven chapters:

**Chapter 1 Installation**
This chapter describes system requirements and gets you started installing ShapeDesigner™ software.

**Chapter 2 Overview of ShapeDesigner™ environment**
This chapter presents the environment and basic functionalities of ShapeDesigner™.

**Chapter 3 Very Fast Step-by-Step Description**
This chapter presents very brief overview of how to use ShapeDesigner™.

**Chapter 4 Step-by-Step Description**
This chapter presents a step-by-step description to show most functionalities of ShapeDesigner™ from starting the application to printing results.

**Chapter 5 Commands and Toolbars**
This chapter presents an overview of the operations of ShapeDesigner™ and a summary of the commands used.

**Chapter 6 Components and Tips**
Using practical examples, this chapter presents an overview of the operations of ShapeDesigner™ components and tips used in sketching and designing shapes.

**Chapter 7 Techniques and conventions**
This chapter discusses the numerical methods used by ShapeDesigner™ using examples.
# Table of Contents

LICENSE AGREEMENT ........................................................................................................... III
 SHAPEDESIGNER(TM) SOFTWARE-AS-A-SERVICE SUBSCRIPTION AGREEMENT ......................... III
 ABOUT THIS MANUAL .......................................................................................................... VII
 TABLE OF CONTENTS ........................................................................................................... VIII

## CHAPTER 1 INSTALLATION

- SYSTEM REQUIREMENTS .................................................................................................. 14
- INSTALLING SHAPEDESIGNER™ SAAS ............................................................................ 14
- STARTING SHAPEDESIGNER™ ....................................................................................... 15
- SIGN IN SHAPEDESIGNER™ ........................................................................................... 15
- LICENSE TYPES ............................................................................................................. 16
- TROUBLESHOOTING CONNECTION PROBLEMS ........................................................... 16
  - Check your Local Area Network (LAN) Settings ......................................................... 17
  - Check local applications ......................................................................................... 17
  - Check proxy applications ...................................................................................... 17
- RUNNING INTERACTIVE HELP ...................................................................................... 18
- MECHATOOLS Team ........................................................................................................ 18
- HOW TO CONTACT MECHATOOLS TECHNOLOGIES SUPPORT .................................. 18

## CHAPTER 2 SHAPEDESIGNER ENVIRONMENT

- ENVIRONMENT ............................................................................................................... 20

## CHAPTER 3 VERY FAST STEP-BY-STEP DESCRIPTION

- START SHAPEDESIGNER™ ............................................................................................. 21
- CREATE A NEW PROJECT ................................................................................................ 21
- SET THE PROJECT UNITS ............................................................................................. 21
- SET THE PROJECT PREFERENCE .................................................................................. 22
- IMPORT A DXF FILE ........................................................................................................ 23
- COMPUTE PROPERTIES ................................................................................................... 24

## CHAPTER 4 STEP-BY-STEP DESCRIPTION

- HOW YOU SHOULD READ THIS CHAPTER ................................................................ 26
- STARTING SHAPEDESIGNER™ ....................................................................................... 26
- CREATING A NEW PROJECT .......................................................................................... 26
- SETTING THE PROJECT PREFERENCE ............................................................................ 27
- SETTING THE SECTION PROJECT UNITS ..................................................................... 32
- SETTING THE BOUNDING BOX ..................................................................................... 32
- CREATING SHAPES ......................................................................................................... 34
  - Guidelines for Creating Shapes ................................................................................ 35
  - Creating Shapes by Importing DXF Files .................................................................. 35
  - Creating Shapes Using Standard Sections (AISC, CISC and British Standard) ....... 43
  - Creating Shapes Using General Parametric Shape ................................................. 43
  - Creating Shapes Using Keyboard Input .................................................................... 44
  - Creating a Custom Shapes Using the Mouse Pointer .............................................. 44
  - Creating a Custom Shapes from File ....................................................................... 45
  - Creating Custom Shapes by Function ....................................................................... 45
- SETTING MATERIAL PROPERTIES ............................................................................... 47
- SELECTING THE REFERENCE MATERIAL .................................................................... 49
- SELECTING SHAPES AND HOLES ................................................................................. 49

© MECHATOOLS TECHNOLOGIES INC. 2010
## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOLES OR CUT-OUTS</td>
<td>52</td>
</tr>
<tr>
<td>CREATING HOLES</td>
<td>53</td>
</tr>
<tr>
<td>DELETING SHAPES AND HOLES</td>
<td>53</td>
</tr>
<tr>
<td>MOVING SHAPES (AND HOLES) WITH THE MOUSE POINTER (OR ARROW KEYS)</td>
<td>53</td>
</tr>
<tr>
<td>CREATING SHAPES WITHIN SHAPES</td>
<td>53</td>
</tr>
<tr>
<td>MODIFYING SHAPES (AND HOLES) BY MOVING POINTS WITH THE MOUSE POINTER</td>
<td>54</td>
</tr>
<tr>
<td>ZOOMING</td>
<td>55</td>
</tr>
<tr>
<td>USING THE GRID</td>
<td>55</td>
</tr>
<tr>
<td>COPYING SHAPES AND HOLES</td>
<td>55</td>
</tr>
<tr>
<td>ROTATING SHAPES</td>
<td>55</td>
</tr>
<tr>
<td>MOVING SHAPES ACCURATELY (TRANSLATE)</td>
<td>57</td>
</tr>
<tr>
<td>SCALING SHAPES</td>
<td>57</td>
</tr>
<tr>
<td>ALIGNING THE CENTROID OF A SHAPE ON THE X AND Y AXES</td>
<td>58</td>
</tr>
<tr>
<td>MOVING SHAPES RELATIVE TO EACH OTHER</td>
<td>58</td>
</tr>
<tr>
<td>MERGING SHAPES</td>
<td>60</td>
</tr>
<tr>
<td>DELETING POINTS</td>
<td>62</td>
</tr>
<tr>
<td>MODIFYING SHAPES (MOVING POINTS) ACCURATELY</td>
<td>63</td>
</tr>
<tr>
<td>GENERATING SHAPES</td>
<td>63</td>
</tr>
<tr>
<td>REFRESHING THE DRAWING AREA</td>
<td>64</td>
</tr>
<tr>
<td>LICENSE STATUS DESCRIPTION</td>
<td>65</td>
</tr>
<tr>
<td>ADDING LABELS TO SHAPES (NOTES)</td>
<td>65</td>
</tr>
<tr>
<td>DIMENSIONING SHAPES</td>
<td>66</td>
</tr>
<tr>
<td>EDITING SHAPE DIMENSIONS</td>
<td>67</td>
</tr>
<tr>
<td>SAVING A SECTION PROJECT FILE</td>
<td>68</td>
</tr>
<tr>
<td>EXPORTING SHAPES TO OTHER APPLICATIONS</td>
<td>68</td>
</tr>
<tr>
<td>SETTING THE APPLIED LOADS</td>
<td>68</td>
</tr>
<tr>
<td>MESHING AND COMPUTING GEOMETRIC PROPERTIES</td>
<td>69</td>
</tr>
<tr>
<td>Changing the Mesh Density</td>
<td>70</td>
</tr>
<tr>
<td>Linking Common Shape Boundaries Together</td>
<td>71</td>
</tr>
<tr>
<td>Checking Common Boundary Linking</td>
<td>72</td>
</tr>
<tr>
<td>PRINTING THE MESH</td>
<td>73</td>
</tr>
<tr>
<td>COMPUTING PROPERTIES</td>
<td>75</td>
</tr>
<tr>
<td>VIEWING RESULTS</td>
<td>75</td>
</tr>
<tr>
<td>Changing Number Format</td>
<td>76</td>
</tr>
<tr>
<td>The General Tab</td>
<td>76</td>
</tr>
<tr>
<td>The Axes Properties Tab</td>
<td>77</td>
</tr>
<tr>
<td>The Custom Tab</td>
<td>78</td>
</tr>
<tr>
<td>Viewing Stress Distributions</td>
<td>79</td>
</tr>
<tr>
<td>Viewing Maximum Stresses</td>
<td>79</td>
</tr>
<tr>
<td>Viewing Stress or Shear Flow at a Specific position</td>
<td>79</td>
</tr>
<tr>
<td>Viewing various Stresses as Iso-Colors</td>
<td>80</td>
</tr>
<tr>
<td>SAVING TABULAR RESULTS</td>
<td>81</td>
</tr>
<tr>
<td>PRINTING RESULTS</td>
<td>81</td>
</tr>
<tr>
<td>DESCRIPTION OF THE CALCULATED PROPERTIES</td>
<td>83</td>
</tr>
<tr>
<td>MULTI-PROJECT SCRIPT</td>
<td>87</td>
</tr>
<tr>
<td>Starting à Multi-Project Script</td>
<td>87</td>
</tr>
<tr>
<td>The Multi-Project Script Window Mode</td>
<td>88</td>
</tr>
<tr>
<td>Adding a ShapeDesigner™ Project to the Multi-Project Script</td>
<td>88</td>
</tr>
<tr>
<td>Removing a ShapeDesigner™ Project from the Multi-Project Script</td>
<td>88</td>
</tr>
<tr>
<td>Viewing the Project Section</td>
<td>89</td>
</tr>
<tr>
<td>Saving the Multi-Project Script</td>
<td>89</td>
</tr>
<tr>
<td>Running the Multi-Project Script</td>
<td>89</td>
</tr>
<tr>
<td>Excluding Sections from the Script</td>
<td>89</td>
</tr>
<tr>
<td>Printing the Multi-Project Script Results</td>
<td>89</td>
</tr>
<tr>
<td>Example of PDF Report of Multi-Project Script</td>
<td>90</td>
</tr>
</tbody>
</table>
CHAPTER 5  COMMANDS AND TOOLBARS .......................................................... 91

MAIN TOOLBAR (MAIN BAR IS ROTATE TO –90 DEGREES) ................................................. 91
TOOLBOX ................................................................................................................... 92
MENUS ...................................................................................................................... 94
FILE MENU (OF THE DRAWING AND DATA TAB) ................................................................. 94
New Project… (Ctrl + N) .......................................................................................... 94
Open Project… (Ctrl + O) ...................................................................................... 94
Save Project (Ctrl + S) ........................................................................................ 94
Save Project As… .................................................................................................. 94
Print… ...................................................................................................................... 94
Import/Export ........................................................................................................ 94
Exit......................................................................................................................... 95
EDIT MENU (OF THE DRAWING AND DATA TAB) ............................................................ 95
Undo (Ctrl + Z) .................................................................................................... 95
Redo (Ctrl + Z) .................................................................................................... 95
Cut (Ctrl + X) ....................................................................................................... 95
Copy (Ctrl + C) ...................................................................................................... 95
Paste (Ctrl + V) ..................................................................................................... 96
Delete (Del) .......................................................................................................... 96
OPTIONS MENU (OF THE DRAWING AND DATA TAB) ..................................................... 96
Preferences .......................................................................................................... 96
Change Bounding Box ......................................................................................... 96
Change Units....................................................................................................... 96
VIEW MENU ........................................................................................................... 97
Points and Ids ....................................................................................................... 97
Shapes Ids ............................................................................................................ 97
Axes ....................................................................................................................... 97
Grid ........................................................................................................................ 98
Units ....................................................................................................................... 98
Zoom In ................................................................................................................ 98
Zoom Out ............................................................................................................. 98
Zoom Win ........................................................................................................... 98
Add (Horizontal, Vertical, Oblique) Dimension ...................................................... 98
View Dimensions .............................................................................................. 98
Shapes Labels ..................................................................................................... 98
SHAPE MENU .......................................................................................................... 98
Modify .................................................................................................................... 99
Move ...................................................................................................................... 99
Flip about X Centroid (Flip Horizontal) .............................................................. 99
Flip about Y Centroid (Flip Vertical) .................................................................... 99
Align Shape Centroid to X-Y Origin .................................................................... 99
Align All Shape Centroid to X-Y Origin ............................................................... 99
Generate… and Transform.................................................................................... 99
Color ...................................................................................................................... 100
Delete.................................................................................................................. 100
Hatches ............................................................................................................... 100
Properties/Geometry............................................................................................ 100
Properties/Material ............................................................................................ 100
Properties/Label Property.................................................................................. 100
Add Hole............................................................................................................. 100
Snap Shapes ...................................................................................................... 101
Add Hole............................................................................................................. 101
View Selected Shape Dimensions ..................................................................... 101
View Selected Shape Automatic Dimensions .................................................... 101
SHAPE OPTIMIZATION .................................................................................................................. 124
SYMBOLIC FUNCTION .................................................................................................................... 125
RESULTS QUALITY ......................................................................................................................... 126
UTILITIES ........................................................................................................................................ 127
UNITS CONVERTER .......................................................................................................................... 127

CHAPTER 7  TECHNIQUES AND CONVENTIONS ............................................................................. 128
THEORETICAL BACKGROUND ......................................................................................................... 128
PRINCIPAL STRESSES ...................................................................................................................... 130
EQUIVALENT VON-MISES STRESS ................................................................................................. 130
EQUIVALENT TRESCA STRESS ....................................................................................................... 130
NEUTRAL AXIS ............................................................................................................................... 130
SHAPE FACTOR ............................................................................................................................. 131
ALLOWABLE-STRESS DESIGN ......................................................................................................... 132
COMPOSITE SECTION ...................................................................................................................... 132
SHEAR STRESSES DUE TO SHEAR FORCES .................................................................................. 132
SHEAR CORRECTION FACTORS (TIMOSHENKO AND REISSNER MODELS) .................................. 133
FLEXURAL-TORSIONAL CONSTANT ............................................................................................... 133
STABILITY .......................................................................................................................................... 134
SHEAR IN BUILT-UP BEAMS (CONNECTORS CALCULATION) ....................................................... 134
HOW TO AVOID TORSION?* ........................................................................................................... 139
REPORT PROBLEMS OR ERRORS .................................................................................................... 140

EXAMPLES ....................................................................................................................................... 141
COMPUTING J AND CW .................................................................................................................... 141
COMPUTING OF THE TWIST ANGLE: .............................................................................................. 141
  Torsion of Thin-wall I section member ......................................................................................... 141
COMPOSITE SECTION ...................................................................................................................... 142
  Composite Section ....................................................................................................................... 142
AXIAL STRESS DISTRIBUTION (BENDING MOMENT EFFECTS) ....................................................... 143
RESIDUAL STRESSES ...................................................................................................................... 144
SHEAR STRESSES ........................................................................................................................... 144
  Rectangular section ....................................................................................................................... 144
  Circular section ............................................................................................................................ 146
  Rectangular section with holes ..................................................................................................... 146
  Composite rectangular section ..................................................................................................... 148
SHEAR STRESSES AND BIMOMENT EFFECT ................................................................................. 150
  I section ........................................................................................................................................ 150
SHEAR FLOW IN BUILT-UP BEAMS AND CONNECTORS CALCULATION ....................................... 155
  Box wood section .......................................................................................................................... 155
  Mixed Section: Steel-Concrete ..................................................................................................... 157
MOMENT CAPACITY OF A COMPOSITE BEAM (BS 5950) ............................................................ 160

INPUT AND OUTPUT FILES ............................................................................................................. 161
OUTPUT REPORT FILE (TO PRINTER OR PDF FILE) ................................................................. 161
INPUT FILE ..................................................................................................................................... 163
OUTPUT FILE ................................................................................................................................. 166
REFERENCES ................................................................................................................................... 168

© MECHATOOLS TECHNOLOGIES INC. 2010
System Requirements

ShapeDesigner™ runs on Windows™ XP/2003/Vista/7. It will not run on previous versions of Windows. It requires a Pentium class CPU or better and a minimum of 512 MB of free memory is recommended. The software requires 100 MB of free space on your hard disk.

Installing ShapeDesigner™ SaaS

You may keep previous versions of ShapeDesigner™ when installing the SaaS version. To install ShapeDesigner™ SaaS, download the software using the administrator account at:


Click on the “Download Software” link in the “Operations” section. Select “ShapeDesigner” and save the downloaded ZIP archive to your computer. Extract the files to a temporary directory and run the setup.exe program.

If you are the administrator and you want to install ShapeDesigner™ SaaS on multiple computers, you may copy, redistribute the downloaded ZIP archive and make it available on your company network.

To install ShapeDesigner™ SaaS run the setup.exe program located in the extracted ShapeDesigner™ SaaS folder. The user needs to have administrator privileges to install and update ShapeDesigner™ SaaS software, but not to run ShapeDesigner™ SaaS.

1. If the user does not have administrator privileges, a window pops up, depending on the installed Windows system – Vista, 7 or XP. Enter the administrator username and password, to continue ShapeDesigner™ SaaS installation (In Windows XP, use the “The following user:” option).

2. If the user has administrator privileges in Windows XP, select the “Current user” option and uncheck the “Protect my computer and data from unauthorized program activity” sentence, as illustrated bellow.

Uncheck
Starting ShapeDesigner™

By default, the ShapeDesigner™ installation will, create menu items in the Program Files directory. To run the program, choose Start | All Programs | MechaTools | ShapeDesigner SaaS | ShapeDesignerSaaS

Sign In ShapeDesigner™

When ShapeDesigner™ is started, the “Sign In” dialog is displayed. Enter the username and password issued to you by your administrator or the administrator username and password specified when the account was created online at:

http://www.mechatools.com/en/saas/create
If you uncheck the “I am using a public or share computer” checkbox, then your username and password will be saved on your computer and you will not be asked to provide them when starting the application.

Click on the “Login” button to connect to the Internet. If you get a connection error message, see the “Troubleshooting Connection Problems” section below. If you get other types of errors such as “invalid username or password” or warnings such as license messages, then ShapeDesigner™ is correctly installed and accesses the Internet correctly.

License Types

ShapeDesigner™ software is licensed either to individual users or to companies and institutions. The license agreement is included at the beginning of this document. It is displayed when you download the software and is posted on our web site at www.mechatools.com. Essentially, the license agreement states that you may use the software as specified by the license type you purchased:

1) An unlimited license performs an unlimited number of computations on a single computer for any user.
2) A floating license performs an unlimited number of computations on any one computers of a network for any user
3) A limited license performs a limited number of computations on any computers for a specific user

For more information, please contact MechaTools Technologies.

Troubleshooting Connection Problems

MechaTools SaaS applications may need special configurations if your company/institution uses security software, firewalls, proxies etc. First, try connecting to the Internet and if you succeed, you can ignore this section.
Check your Local Area Network (LAN) Settings

In Windows, click “Start” and then click “Control Panel”. Click “Network and Internet” and then click “Internet Options”. Click the “Connections” tab. Click on the “LAN Settings” button. The “Local Area Network (LAN) Settings” dialog is displayed.

If “Automatically detect settings” or “Use automatic configuration script” is checked, then you might need assistance from your IT specialist. Do not uncheck these values.

Unlike web browsers, MechaTools applications are incapable of handling these two options. They will simply be ignored and this will most probably prevent connection to the Internet. Typically, your IT specialist should enter the address and the port of a proxy server in one of the following two locations:

a) The “proxy server” section of the “Local Area Network (LAN) Settings” dialog.

b) The login page of the MechaTools application.

Both are equivalent but MechaTools applications will use the login page value first. If the proxy server is not set in the login page, then the application will use the “Local Area Network (LAN) Settings” value.

The “Proxy Server” part of the ShapeDesigner™ login dialog is only displayed if connection problems are detected.

Note that MechaTools applications cache the proxy server configuration. If you modify the “proxy server” section of the “Local Area Network (LAN) Settings” dialog, you must restart the application for these changes to take effect.

Check local applications

Some applications and services such as ZoneAlarm firewall may block/allow specific applications to Access Internet. Check with your IT specialist if any of these applications may be present on your computer.

Check proxy applications

Some applications such as Microsoft Forefront Threat Management Gateway (formerly known as Microsoft Internet Security and Acceleration Server) may block/allow specific URL, http request … Consult your IT specialist for assistance on how to allow MechaTools application to access the Internet. Note that MechaTools applications connect exclusively to www.mechatools.com.
Running Interactive help

To run the interactive help, choose Start | Program | MechaTools | ShapeDesigner SaaS | Interactive help

To run the interactive help inside ShapeDesigner™, from menu choose Help | Interactive help

MechaTools Team

ShapeDesigner™ is the easiest way for engineers to efficiently determine properties and perform stress analysis on sections. ShapeDesigner™ was developed by professionals and engineers using state of the art methods in finite elements and sophisticated algorithms. ShapeDesigner™ is robust, scalable and very easy to use.

How to Contact MechaTools Technologies Support

The best way to obtain technical support from MechaTools is through our technical support web page at: http://www.mechatools.com/en/support.html. To contact us, you may call 418 265.5171 or send an email at contact@mechatools.com. Our office hours are 8:30AM - 5:00PM Eastern Time US & Canada (GMT-05:00).
CHAPTER 2

ShapeDesigner Environment

Environment

The ShapeDesigner™ environment is shown in the picture below.

The main menu, toolbars, and status bar are standard Windows components. The status bar at the bottom provides contextual help, hints and messages. It displays the current filename, the mouse position and the centroid of the selected shapes.
CHAPTER 3

VERY FAST STEP-BY-STEP DESCRIPTION

This is a very fast walkthrough of ShapeDesigner™. Explanations are given in the next example in chapter 4. This example is designed to provide a brief overview of the software.

Start ShapeDesigner™

Start ShapeDesigner™ with the Start | Programs | MechaTools | ShapeDesigner SaaS menu and authenticate using your username and password.

Create a New Project

Select the New Project icon in the Starting a Project dialog.

The Input Filename for New Project dialog is automatically displayed. Enter the name of your new section project and click Save.

Set the Project Units

Click Cancel on the Change Units dialog.
Set the Project Preference

Click Cancel on the Preferences dialog.
Import a DXF File

1. Select the **DXF Module** tab.

2. From the **DXF File Manager**, select the ShapeDesigner example folder (c:\Program Files\MechaTools\ShapeDesigner SaaS\Examples).

3. Select the DXF file from the file list (goodridge.dxf).

4. Press the **Accept** button. The **DXF File Manager** tab will close and the **DXF Editor** tab will be displayed.

5. Press the **DXF to Shape Designer** Button to import the section.
Compute Properties

Click on the Mesh & Computing tab.

Click on the Compute Section Properties button. Wait for the results to be displayed.
View the various results.
How You Should Read this Chapter

Chapter 4 covers most of the ShapeDesigner™ functionality in details. Depending on your needs and your use of the program, you may want to skip some of these sections. Specifically, if you do most of your CAD work with another tool such as AutoCAD™, you may want to skip most of the sections pertaining to building shapes (about 24 pages). In this case, you should read this chapter until you finish reading the “Creating Shapes by Importing DXF Files” section. You should then skip to the “Setting Material Properties” section and finish the chapter.

Starting ShapeDesigner™

Start ShapeDesigner™ with the Start | Programs | MechaTools | ShapeDesigner SaaS menu and authenticate using your username and password.

Creating a New Project

To create a new section project, select the New Project icon in the Starting a Project dialog. Click on the New Project button in the toolbar or in the File menu select the New Project to display the Starting a Project dialog.

The Input Filename for New Project dialog is automatically displayed. Enter the name of your new section project and click Save. This dialog may be invoked at any time using the File menu.
Setting the Project Preference

The Preferences dialog is used to set various project specific properties. This dialog may be invoked at anytime from the Options menu by selecting the Preferences ... option or by clicking on the Preferences icon on the main toolbar. This dialog is automatically displayed when starting a new project.

Properties are grouped in categories displayed as tree nodes on the left side of the dialog. For example, the “identification” node groups all properties related to project identification. The property values are displayed on the right side of the dialog.

The Set as default preferences checkbox saves the values of all properties of all categories (not just the currently displayed values) as default values to be used whenever a new project is started. The Reset to default button restores values of all properties of all categories to the last saved values (not to the original system values). The Ok button applies the changes made to all properties of all categories. The Cancel button reverts to the values set before the dialog was invoked.

For most of the categories, you may accept the default property values. The two categories you may want to change are “Identification” and “Units”.

The Identification category contains the project identification information. The “Company” property is read only and is set by your administrator using the web interface. The “Version” property is also read-only and corresponds to the software version number. These properties are displayed in the various generated reports. The “Client”, “Project”, “Task” and “Project Ref” properties differ from all other properties in that they are not saved when the “Set as default preferences” checkbox is checked.
The **Color** category is used to set the color of various display elements. The current color is shown to the right of the element. Clicking on the current color activates the **Color** dialog to help you select a new value.

The **Font** category is used to set the font of various display elements. The current font is shown to the right of the element. Clicking on the current font activates the **Font** dialog to help you select a new value.
The **General** category is used to set various general-purpose properties. These properties are grouped under two tabs: “Mesh & FEA Parameters” and “Sketch Parameters”.

Mesh & FEA Parameters: (FEA stands for Finite Element Analysis)

a) **AutoCompute Properties**: When checked, ShapeDesigner™ automatically meshes the geometry with an optimal density in the “Mesh & Computing” tab. When left unchecked, you must select the mesh density explicitly, mesh the geometry and review the mesh before moving to the computation phase. This checkbox is also displayed in the “Mesh & Computing” tab.

b) **Point inside shape ratio**: This value is used to define a relative tolerance used to detect shapes and holes. The default value of 1000 means that the tolerance is 1/1000 of the maximum X and Y dimension. You should rarely, if ever, have to modify this value. In some very rare cases involving multiple shapes or holes with very thin walls in contact with each other, the meshing process may fail. You should first make sure the geometry is correct as this is almost always the real problem. As a last resort, try to increase this value by a factor of 10 or 100.

c) **Tolerance to link shapes (FEA)**: When multiple shapes are assembled to form a built-up section, a tolerance value is used to determine if the shapes should be “linked” together. When a node from a shape is closer than this tolerance value to another shape, the node will be “linked” to this shape. Depending on the problem being solved, you may want to
   a. Move certain shapes to make sure they fall inside or outside this tolerance value,
   b. Change the tolerance value; or
   c. Both
The second group of properties under the General category is the “Sketch Parameters”.

![Sketch Parameters](image)

**Sketch Parameters:**

d) **Number of divisions per circle**: Circles are approximated by line segments. This value determines how many such segments are to be used for this approximation. The default value of 80 is generally Ok for most problems and should not be changed.

e) **Grids spacing ticks**:

f) **Snap mouse to nodes**:

g) **Snap mouse to nodes (pixel)**: maximum value between mouse and node to snap it.

h) **Step to move shape in X direction**: step in pixel to move shape with left-right arrow key.

i) **Step to move shape in Y direction**: step in pixel to move shape with up-down arrow key.

j) **Auto Bounding box**: When checked, ShapeDesigner™ automatically resizes the bounding box to include exactly all the current shapes. See “Setting the Bounding Box” section for more details.

The Stresses category is used to specify the number of divisions when viewing results. This value is “Not” the number of iso-colors. This value affects the rendering of stresses as displayed in the Stresses tab of the View toolbox of the Result tab.
The **Units** category is used to specify the units and the numerical display format used by ShapeDesigner™. Double click on the units and the **Change Units** dialog will be displayed. See the “Setting Section Project Units” section below for more details. Select the display format for floating point values using the “Number Format” dropdown list.

The **DXF Properties** category is used to specify the parameters when importing DXF files in ShapeDesigner™.

**Small arc divisions:** W  
**Tolerance to link points:** W  
**Ratio (Large dim/Small radius):** W  
**Erase duplicate nodes:**  
**Warning message to erase duplicate nodes:** W  
**View DXF Text:** By default, when showing DXF files, ShapeDesigner™ does not show the contained text. In some cases, it may be useful to display this text and this option allows you to do this. Note that this option is also available in the “DXF File Manager” of the “DXF Module” tab.  
**Approximate Small Arcs:**
Setting the Section Project Units

The Change Units dialog is used to select the units to be used by ShapeDesigner™ for all future operations. The Change Units dialog may be invoked at any time by:

1) Clicking the Change Units icon on the toolbar.
2) From the Options menu by clicking Change Units ... option.
3) From the Preferences dialog in the units category.

The Change Units dialog is automatically displayed when starting a new project if you have not previously checked the “Set as Default Units for Future Projects”. Note that changing units actually performs unit conversions when shapes are loaded. For example, a 1-inch edge becomes a 2.54 cm edge. Click the Apply button when you are done.

You can use the selected units in the future projects by selecting on the “Set as Default Units for Future Projects” checkbox.

Setting the Bounding Box

The “bounding box limit” and the “auto bounding box checkbox”, in conjunction with the zoom buttons, control which portion of the drawing is displayed in the drawing area. The bounding box is an imaginary box that surrounds a region of the drawing. Zooming operations are based on the size and position of the bounding box. For example, the Zoom All command resizes and moves the viewport so that the bounding box is centered and fully visible in the drawing area. After the Zoom All command is executed, the Zoom dropdown is set to 100%.

The bounding box limit is defined by setting the minimum and a maximum X and Y value to be displayed in the drawing area. There are two methods of setting this limit:

1) Manually specifying explicit values in the Bounding Box Boundary dialog.
2) Using the mouse pointer to select a region in the drawing area.
To set the limit, from the Options menu select the Change Bounding Box option and then select one of the two methods described above. When you select the Manually… option, the Bounding Box Boundary dialog is displayed to set the limit values. When you select the Mouse option, the mouse pointer changes to a horizontal cross and you can then select the part of the drawing area to use as the limit.

By default, ShapeDesigner™ automatically resizes the bounding box to include exactly all the current shapes. When a shape manipulation causes a shape to exceed the bounding box limit or to be smaller than this limit, the bounding box will be resized. This default behavior may be counter productive when the user is trying to concentrate on a particular region of a drawing. The Auto Bounding Box checkbox, located in the Bounding Box Boundary dialog and in the Preferences dialog, in the General properties, under the Sketch Parameters tab, is used to turn off automatic resize.
Creating Shapes

Assembling shapes with holes creates sections. To specify whether a shape or a hole is to be inserted in the drawing area, from the Main Toolbox under the Cross Section Input tab, click the Add Shape or the Add Hole toggle button. Because holes can only be added to shapes, the Add Hole toggle button is not accessible if a shape is not selected.

Pressing the Add Shape or Add Hole toggle button activates the list of shape definition modes. Select one of the five shape definition modes.

1) **Standard Shapes...** Inserts standard steel sections from a library of all standard AISC (American Institute of Steel Construction), CICS (Canadian Institute of Steel Construction) and BS (British Standards) sections.
2) **Parametric Shapes...** Inserts predefined parametric shapes from a library containing all common sections such as Multi-Stiffeners, (including all AISC shapes).
3) **Custom Shapes...** Creates user-defined shapes using one of the following methods:
   a. Freehand using the mouse pointer.
   c. Using complex mathematical functions.
4) **Input by Keyboard...** Creates user-defined shapes using a Microsoft Excel like table of X and Y coordinates.
5) **Import DXF file...** Imports a DXF format file to ShapeDesigner™.
Guidelines for Creating Shapes

The method used to create shapes and the number of shapes required is specific to the problem being solved. The following guidelines should be followed.

1) ShapeDesigner™ assigns material properties to shapes. If you plan to use various materials, you will need at least one shape per material type.
2) ShapeDesigner™ automatically links (glues) together common shape boundaries. To detect common shape boundaries, the distance between two boundaries is compared to a very small tolerance value specified in the Options/Preferences/General/Mesh & FEA Parameters/Tolerance to Link Shapes property. If this distance is smaller than the tolerance value, the boundaries are assumed to be linked. Users should be very precise when assigning point coordinates.

Creating Shapes by Importing DXF Files

Select the Import DXF File… option or click on the DXF Module tab to import DXF files in ShapeDesigner™ or from the File menu select the Import/Export Import Section from DXF file option. Use this option when you want to import a shape that was defined in another CAD. ShapeDesigner™ reads DXF files and provides functions for extracting and cleaning data before it is imported. The DXF file can be a collection of polylines, lines, arcs and circles.

How Should a DXF be Formed?

ShapeDesigner™ expects a DXF to represent a series of shapes and holes drawn as a closed list of graphical elements such as lines, arcs … How a DXF is created, influences how easily it can be imported in ShapeDesigner™. A DXF can be a simple well structured closed polyline (which, by the way, may be made up of graphical elements other than lines) or an unordered set of thousands of lines, arcs, circles … A DXF polyline is easily imported because it already encompasses the structure and ordering required. On the other hand, when given an unordered set of lines, arcs, circles …, ShapeDesigner™ must discover the shapes and holes by finding which elements follow each other and in what order. This process may need user intervention in some cases.

Step-by-Step Import of a DXF File

1. Go to the DXF File Manager by clicking on the DXF Module tab or by selecting the Add Shape | Import DXF File… option in the Cross Section Input tab of the Drawing & Data. Note that by switching to the DXF Module tab, menu options are changed. For example the File |
Open Project... option is not available anymore. If the DXF Editor is displayed, from the main menu select File | Open DXF File..

2. Select the folder where the DXF file resides in the folder tree.

3. Select the DXF file from the file list. The selected DXF file is previewed in the drawing area.

4. Some strangely formed DXF files contain drawing elements in blocks. If your DXF is missing information, check the Load Block option. This option is off by default but is turned on automatically if nothing is found in the DXF.

5. Check the View DXF Text checkbox to view textual information in your DXF that is typically not required when importing sections.

6. If the DXF file contains unwanted information for section analysis, you can pre select a specific part of the DXF for the DXF Editor using the mouse pointer in the drawing area. Completion of the mouse selection automatically accepts the DXF file with the pre selection and goes directly to the DXF Editor. Note that this pre selection step with the mouse pointer is only a shortcut to the DXF Editor which offers the same functionality and more. The DXF Editor section below describes how to perform a finer selection.
7. Click the Accept button to perform a pre selection of the whole DXF file content and go directly to the DXF Editor. The DXF Editor will allow you to refine your selection before the DXF is actually imported in ShapeDesigner™.

8. The DXF Editor is an intermediate step before importing the DXF file in ShapeDesigner™. If the DXF Editor selection contains only the desired section without unwanted information like other sections, projections …, press the import button to import the current selection to ShapeDesigner™.

During import, the import button is disabled and a progress bar is displayed.

9. Follow the DXF Editor instructions below to finely select part of a DXF file.

The DXF Editor
The DXF Editor is used to select, edit and help import DXF sections in ShapeDesigner™.

Setting the DXF Dimension Unit
A DXF file is unitless when it is created without specifying the dimension unit (mm, inch …). In this case, you can explicitly specify the dimension unit using the “Original DXF Unit” dropdown list. If you forget to set the unit, you will be reminded when you perform the import. It is important to note that the dimension unit you specify is the one used to draw the DXF in the other CAD. If you work with another unit type within ShapeDesigner™, the DXF dimensions will be converted later during import.
If the dimension unit has been improperly set, you may override its value by clicking on the small lock icon to the right of the “Original DXF Unit” dropdown list. This enables the “Original DXF Unit” dropdown list. Changing this value does not perform a conversion (1 mm will become 1 cm or 1 inch). If you work with another unit type, the DXF dimensions will be converted later during import.

Selecting the DXF Elements
To import shapes and holes from a DXF, you have to select the part of the DXF that contains the information you want to import. For example, if a drawing contains a front, a horizontal and a profile view, you will select the front view for import. If a drawing contains multiple sections, you will import only one of them. To select the DXF elements, click on the Select Item (Shapes) by Mouse icon.

If there was a previous selection, it will be canceled and you will be placed in selection mode. Using the mouse pointer, select the part of the DXF you want to import.
In most cases, ShapeDesigner™ will automatically detect the selected shapes and holes and will display the selected result as shown in the next figure.
If you are satisfied with your selection, click on the **DXF to ShapeDesigner™** button and the selected section will be imported in your current project. If you have not captured all the desired shapes, you can start over your selection by clicking again on the **Select Item (Shapes) by Mouse** icon. If you want to remove unwanted shapes, you can use the fine selection detailed in the next section. If the DXF does not render correctly, you will have to go to **Advanced** mode to guide the shape selection.

**Fine Selection**

In the previous example, the shape selection operation was simplified because the DXF was made up of three well formed polylines. When you do not have such a well formed DXF, or when you are not able to select your shapes with the mouse pointer, you may use the **Shape List** to remove unwanted shapes or the **Advanced** mode to guide shape selection.
Shape List

The Shape List tab lists all the closed polylines (shapes and holes) that were discovered in the current selection. Shapes are listed in blue while holes are listed in red and indented within the containing shape. ShapeDesigner™ automatically assigns shape or hole type. Because it can’t know for sure if a polyline represents a hole or a shape (with another material), ShapeDesigner™ allows you to change the shape type by clicking on the “type” column.

Polylnes may be moved up or down with the arrow keys to ensure holes are contained in the right shape when you change the polyline type. Click on the polyline name to select it then click the arrow buttons.

When the “view” column checkbox is set, the corresponding polyline is displayed and flagged to be imported. Otherwise, the polyline will be hidden and ignored when the DXF is imported. Because holes are contained in Shapes, if a shape is unchecked, all its holes will be unchecked automatically. Clicking on the View column header will select or unselect all polylines.

To reduce cluttering in the shape list, you may delete polylines by clicking on the corresponding “delete” icon on the right side of the list. This will automatically hide the polyline and ignore it when the DXF is imported.
DXF Preferences

- Number of points to approximate small arcs

- If the ratio of the large dimension / radius of arc is smaller than this ratio, the arc is considered a small arc

- Approximate or not the small arcs

**Section**

**Possibility1 DXF**

- Circle1
- Arc4
- Line4

**Possibility2 DXF**

- Circle1
- Polyline 1 (this possibility is obtained by applying the *Explode* command in AutoCAD™)
- Line1
- Arc1
- Line2
- Arc2
- Line3
- Arc3
Creating Shapes Using Standard Sections (AISC, CISC and British Standard)

When you select to build a section using the **Standard Shapes...** option, the **Standard Steel Shapes** dialog is displayed. This dialog uses the MechaTools STDShapeLib™ visual component to select a standards section. STDShapeLib™ is described in detail in chapter 6: Components and tips. STDShapeLib™ allows you to select a standard steel section using multiple optimal geometric search criterions. STDShapeLib™ also allows you to translate and rotate the section before it is added to the drawing area. Once you have selected the section, click **Apply** to add it to the drawing area.

Creating Shapes Using General Parametric Shape

When you select to build a section using the **Parametric Shapes...** option, the General Parametric Shape dialog is displayed. This dialog uses the MechaTools GenShapeLib™ visual component to select a general shape. GenShapeLib™ is described in detail in chapter 6: Components and tips. GenShapeLib™ allows you to select a standard parametric shape and to resize it using its parameters. The geometric properties of the resized shape may be set before the section is added to the drawing area. Once you have selected the shape, click **Apply** to add it to the drawing area.
Creating Shapes Using Keyboard Input

When you select to build a section using the Input by Keyboard option, the Keyboard Input Data dialog is displayed. This dialog allows you to define a shape by inputting ordered points representing a closed polygon. Enter the x and y coordinates of the first polygon point in the X-Y cells. Do not repeat the original point to close the polyline. Once you have completed the definition of the polyline, click the Accept Shape button to close the polyline and commit the resultant shape to the drawing area.

Creating a Custom Shapes Using the Mouse Pointer

When you select to build a shape using the mouse pointer, the application switches to Pointer Definition Mode. In
this mode, the mouse pointer becomes a red pen over the
drawing area. This mode allows you to define a shape by
using the pointer to define an ordered set of points
representing a closed polygon. You add points by placing
the pointer at the desired position and then clicking the
left mouse button. As you add points, the polyline is
displayed in the drawing area. The first polyline point is
displayed in red. When you are done, click on this first
point to close the polyline and commit the resultant shape
to the drawing area. This automatically leaves the Pointer
Definition Mode. Note that freehand drawing using the
pointer generates shapes with imprecise points.

Creating a Custom Shapes from File

Use this option to input a shape geometry using a text
data file. The text file format must follow the rules below:
1) The first line contains the number of points used to
define the polygon.
2) Each of the following lines contains the x and y
coordinates of a polygon point separated by a comma.
3) The polyline is automatically closed so the first point
is not repeated.
The following data file content describes a unit triangle:

```
3
0.0, 0.0
1.0, 0.0
0.0, +0.1E+01
```

Creating Custom Shapes by Function

Use this option to create a custom shape having one of its borders represented by an
approximation of a mathematical function. The Formula dialog is displayed.

Enter the function of x expression in the Function Expression f(x) textbox. For example:

```
5 + Sin(x*PI/2)
```

Enter the left and right limit of the function in the X-Minimum and X-Maximum textboxes. For
example: 0.0, 1.0.
The shape border is approximated by evaluating the function at fixed x intervals between the specified limits and joining the point with line segments. The **Number of Steps** indicates how many line segments will be used.

Click **Compute** to get a preview of the approximation. If you are satisfied with the approximation, click **Accept** to commit the new shape to the drawing area. Note that the committed shape’s borders are specified by:

1) \( y = f(x) \) between X-Minimum and X-Maximum
2) \( x = X\text{-Minimum} \) between \( y = 0 \) and \( y = f(X\text{-Minimum}) \)
3) \( y = 0 \) between X-Minimum and X-Maximum
4) \( x = X\text{-Maximum} \) between \( y = 0 \) and \( y = f(X\text{-Maximum}) \)

The new shape’s label is set to the function expression.

For example, the function: gives:

**Note:** A shape created using this method is generally modified once committed to the drawing area.
Setting Material Properties

When you create the first shape of a new project, the Material Properties dialog is automatically displayed if no default material has been previously specified. The material properties that you select will be used for all subsequent shapes added in the same project. If you are building composite sections, you will have to explicitly set material properties to shapes whose material is not the same as the first shape.

To assign material properties to a shape, from the Drawing and Data tab, select a shape (see “Selecting Shapes and Holes”), From the Shape menu select the Properties/Material… option.

The Material Properties dialog is displayed. Select the Shape Materials tab.

Select the shape to which you want to assign a material using the Shape Number scrollbar. By defaults, the shape that was selected to display the dialog is selected. The selected shape is highlighted in red in the drawing area.
Select the material color by clicking on the **Material Color** button. The button is displayed using the current material color. The color is assigned to the shape material. All shapes using this material will be affected by this change. To view shape colors, from the toolbar click the **Show and Hide Shape Colors** icon.

The shape **Label** is displayed and may be modified. Enter the **Beam Length**. The default value is 1.0 one giving unit length values for properties such as mass, volume... Select the material type using the **Material Type** selection dropdown. The material properties are displayed.

If you want to use the same material type for other shapes, check the shapes in the **Select for Same Material** list. Click **Apply** to commit the current changes and keep the dialog open. Click **OK** to commit the current changes and close the dialog. Click **Cancel** to abort changes made since the last **Apply** and close the dialog.

If you work with a material whose properties are not listed, you may define a new material type and add it to the list of materials. To do this, select the **User-Defined** material type from the **Material** dropdown. When this option is selected, you may enter user-defined values for material properties. Enter the following material properties: **Material Name**, **Young’s Modulus**, **Poisson Ratio**, **Mass Density** and **Yield Stresses**. Young’s Modulus, Poisson Ratio and Yield Stresses are used only in section analysis (not used for geometric property computation).

The values in the material database provided in ShapeDesigner are average values or approximations of material coefficients. Exact values may vary greatly, depending on composition, heat treatment, and mechanical working. Therefore, the tables should be used only for educational purposes. For professional practice, obtain material properties from the supplier of materials.

Click the **Add Custom Material to My Library** button. You will be prompted for the material name.

Click the **OK** button and the newly defined material appears in the **Material** list.

If you always work with the same material, you may set the default material for all shapes by checking the **Set as Default Material in Future Projects** checkbox.
At anytime you may select the Material Properties tab to get an overall view of material properties. If you do not explicitly define the material type, it defaults to the first material in the material database.

Selecting the Reference Material

When more than one material is specified for a given section, the CAD tab of the CAD and Data tab is enhanced with a reference material selection. Use the horizontal scrollbar to go through the shape list. As a shape is selected, it is highlighted in the drawing area and its material is displayed in the white textbox.

Selecting Shapes and Holes

There are two ways to select shapes and holes in the Drawing & Data tab.
1) Using the Shapes browser.
2) Using the mouse pointer.

To select a shape using the Shapes browser, select the CAD and Data tab from the toolbox and click on the desired shape in the tree list. The tree list is a hierarchical view of the current project. The project is the root node of this tree. Shapes are the following nodes. Each shape node contains its hole nodes. The selected shape or hole is highlighted with a white hatching and a green contour in the drawing area. Basic dimensions and centroid position are also displayed in the drawing area and in the status bar. Other properties, located under the Properties tab, such as area and inertias are also dynamically updated.
To select a shape using the mouse pointer, move the pointer over the shape or the hole in the drawing area then press the left mouse button. If the CAD and Data tab is open, then its information will be updated just as if you had used the tree view to perform your selection.

If the selection is ambiguous, that is more than one shape or hole could qualify as being selected, every subsequent click will select a different ambiguous shape. This is useful for selecting shapes within shapes. See the “Creating Shapes within Shapes” section of this document for more details on selecting nested shapes.
When a shape or hole is selected, the **Shape** menu becomes available. You may also access the **Shape** menu by right clicking the mouse button.
Holes or Cut-Outs

A hole is created within a shape and for its lifetime, a hole remains associated to the shape in which it was created. If you move a shape containing holes, the holes will move along with the shape. If you delete a shape containing holes, the holes will be deleted with the shape.

It is possible to manipulate a drawing such that one or more holes are partially or completely outside the shape in which they were created. This situation must be fixed before computations may begin.

Acceptable section (hole inside the shape)                  Unacceptable section (see error message above if the error is not fixed)

If you try to perform computations when a hole is not completely inside the boundary of its containing shape, you will get an error message similar to this:
Creating Holes

There are various ways of creating holes:

4) Using the Add Hole button of the Cross Section Input tab of the Main Toolbox or using the equivalent Add Hole menu item of the Shape menu.

5) By dragging a shape onto another shape. See the “Creating Shapes Within Shapes” section.

6) By copying a shape or hole and pasting it as a hole. See the “Copying Shapes and Holes” section.

7) By using the Generate Shapes dialog (See the “Generate Shapes” section)

To create a hole, select the shape in which you want to create it. Then, define the hole the exact same way as a shape (See the “Creating Shapes” section) except that, instead of selecting the Add Shape button from the Cross Section Input tab of the toolbox, select the Add Hole button.

Deleting Shapes and Holes

To delete a shape or a hole, select it and then press the Delete key or click the Delete Shape icon of the toolbar or from the Edit menu select Delete. A confirmation is always required to delete a shape or a hole. Note that shape names, hole names, point names are renumbered when a deletion occurs. If a shape containing holes is deleted, all its holes are also deleted.

Moving Shapes (and Holes) with the Mouse Pointer (or Arrow Keys)

To move a shape with the mouse pointer, select the shape, then, from the Shape menu click Move. You can also click the Move Selected Shape by Mouse icon in the CAD tab of the CAD & Data tab of the toolbox. The selected shape becomes movable. Move the shape using the left mouse button in the drawing area or using the arrow keys. When you release the left mouse button, the shapes return to the unmovable state. Click the right mouse button or on the Option icon of the CAD tab to return to the unmovable state. If a shape containing holes is moved, all its holes are also moved.

If you want to move all shapes, from the CAD and Data tab of the toolbox, select the CAD sub tab. Click Move All Shapes by Mouse.

See the “Moving Shapes Accurately” section of this document for a more accurate method of moving shapes and holes.

Creating Shapes Within Shapes

When you move a shape or create a shape completely within another Shape, ShapeDesigner™ actually creates a hole the same size as the contained shape and places the shape within this hole. The new composite section is treated as a whole when comes the time to move or delete the containing shape.

It is possible to manipulate a drawing such that one or more shapes overlap (i.e. they are not completely in or out of another shape). This situation must be fixed before computations may begin. If you try to perform computations in this state, you will get an error message similar to this:
Modifying Shapes (and Holes) by Moving Points with the Mouse Pointer

To move a shape point, select the shape you want to modify. Then, from the CAD sub tab of the CAD and Data tab, click Modify Shape by Mouse or from the Shape menu select the Modify... option. The shape becomes modifiable.

Move the mouse pointer over a point and click and hold the left mouse button to grab the point. Move the point to the desired location and release the left mouse button. Repeat this as often as required. To end the deleting mode, click on the Option icon or click on the right mouse button. See the “Modifying Shapes Accurately” section for a more accurate method of modifying shapes and holes.

Note that the undo operation applies to all point movements performed, not just the last point moved.
Zooming

Zooming allows you to increase or decrease the size of the drawing viewport. There are five ways of zooming.
1) Using the scroll wheel (mouse wheel) or the Zoom In/Zoom Out icons of the toolbar or the View menu Zoom In/Zoom Out options you may increase or decrease the viewport by 10%.
2) Using the zoom percentage dropdown you may increase or decrease the viewport by an arbitrary value.
3) Using the Zoom All icon of the toolbar you may readjust the viewport so that the bounding box is fully displayed and centered on the drawing area. See the “Setting the Bounding Box” section.
4) Using the Zoom Window icon of the toolbar or the View menu Zoom Window command you may define a selection box with the pointer. Drag the pointer using the left mouse button to draw a selection box around the region you want to zoom. When you release the mouse button, the drawing area will be redrawn so that the selected region occupies the whole drawing area.

Using the Grid

To help position the mouse pointer on the drawing area, it is possible to display/hide the grid. To toggle the grid display, from the toolbar click the Show and Hide Grid icon or from the View menu click the Grid option.

Copying Shapes and Holes

There are two ways of copying shapes: Using the Copy and Paste commands and using the Generate Shape dialog. See the “Generate Shapes” section for description of the Generate Shape dialog.

Select the shape you would like to copy. From the Edit menu, select the Copy option or press CTRL + C. Optionally, move the mouse pointer to the position where the centroid of the “to be pasted” shape should be pasted and click the left mouse button. From the Edit menu, select the Paste option or press CTRL + V. The operations actually performed by this sequence are:

1) The original shapes or/and holes are copied to the clipboard as polygons. The clipboard does not know if the polygons are shapes or holes.
2) The target position is specified using the mouse pointer. If this optional step is not performed, the target position is identical to the position of the shapes being copied.
3) The clipboard polygons are pasted as shapes (not holes) at the target position.

Skipping the optional specification of the target position is particularly useful for defining a shape within shape using a hole to define the inner shape geometry. See the “Defining Shapes within Shapes” section.

To paste a hole using this method, perform the same steps as above but before the pasting step, indicate that you are pasting a hole. To do this, in the Cross Section Input tab of the main toolbox, click the Hole icon or from the Shape menu select the Add Hole option.

Rotating Shapes

To rotate a shape, select it and from the Shape menu select the Transform… option. The Shape Transformation dialog is displayed. Select the Rotate tab to display the rotation options.
By default, the “Shape to be Rotated” is the one you selected when you invoked the dialog. Select the shape you want to rotate in the **Shape to be Rotated** section. You may select a specific shape or **All Shapes**. Note that the horizontal scrollbar in the **Shape to be Rotated** section serves two purposes. If specific shape is selected (i.e. the left radio button is selected), it is used to select the shape to be rotated. If **All Shapes** is selected, it is used to select the shape for the **About Point**. Select the rotation type using one of the five available options:
1) **Free Rotation** rotates the shape the specified **Angle**.
2) **Flip Vertical** flips the shape around a vertical axis.
3) **Flip Horizontal** flips the shape around a horizontal axis.
4) **Rotate Right** rotates the shape clockwise 90 degrees.
5) **Rotate Left** rotates the shape counterclockwise 90 degrees.

In the case of rotation transformations, **About** selects the rotation point. In the case of flipping transformations, **About** fixes the position of the flipping axis. **About** may be one of the following options:
1) **Point** selects a specific geometric point of the selected shape in the **Shape to be Rotated** section (even if **All Shapes** is selected). The point is highlighted in the view area.
2) **Centroid** uses the centroid of the selected shape or the centroid of all shapes as the about point.
3) **X-Y Axis** uses the origin of the Cartesian coordinate system as the about point.
Click **Rotate** to apply the rotation.

The **Shape Transformation** dialog remains displayed for you to proceed to other transformations. Click **Exit** when you are done. Note that all transformations done in the **Shape Transformation** dialog are done in a single transaction and may be undone using the **Edit** menu and selecting the **Undo** option or CTRL+Z.
Moving Shapes Accurately (Translate)

To move shapes accurately, select a shape and from the Shape menu click the Transform icon. The Shape Transformation dialog is displayed. Select the Translate tab.

By default, the “Shape to be Translated” is the one you selected when you invoked the dialog. Select the shape you want to translate in the Shape to be Transformed section. You may select a specific shape or all shapes. Enter the translation values in the dx and dy textboxes. To align the centroid of the selected shapes on the origin of the coordinate system, check the Align Centroid to X-Y Center checkbox. Click Translate to apply the translation. The Shape Transformation dialog remains displayed for you to proceed to other transformations. Click Exit when you are done. Note that all transformations done in the Shape Transformation dialog are done in a single transaction and may be undone using the Edit menu and clicking Undo.

The Shape menu offers the Align Shape Centroid to X-Y Origin and the Align All Shape Centroid to X-Y Origin shortcuts.

Scaling Shapes
By default, the “Shape to be Scaled” is the one you selected when you invoked the dialog.

Aligning the Centroid of a Shape on the X and Y axes

You can move the centroid of a shape so that it is centered on the X and Y axes. Select the shape and from the Shape menu select the Align Shape Centroid to X-Y Origin.

You can also align the common centroid of all shapes so that it is centered on the X and Y axes. Select a shape and from the Shape menu select the Align All Shape Centroid to X-Y Origin.

Moving Shapes Relative to Each Other

When creating built-up sections, you have to position shapes relative to each other. To do this, use the Snap Shapes tool. This tool is more flexible than a “snap to grid” feature as, for example, it allows diagonal moving of shapes.

The Snap Shapes tool is invoked by selecting a shape and then:

1) Selecting the Snap Shapes... item from the Shape menu, or
2) From the Toolbox, under the CAD and Data tab, under the CAD tab, click the Snap Shapes... icon.

The Snap Shapes tool performs one of three operations:

1) It aligns a point on the moving shape to a point on the fixed shape.
2) It aligns a point on the moving shape to a line on the fixed shape. In this case, the point moves in a direction perpendicular to the destination line.
3) It aligns a line on the moving shape to a point on the fixed shape. In this case, the line moves in a direction perpendicular to itself.
The first step is to choose the movement type by selecting one of the three movement buttons at the top of the Snap Shapes dialog. The following images show the three possible cases.

By default, the “Moving Shape” is the one you selected when you invoked the dialog. If it is not already selected, select the shape to move using the horizontal scrollbar in the yellow section. As you scroll through the shapes numbers, the corresponding shape is highlighted using yellow hatching in the drawing area (see screenshot below).

Select the point or side to align on the moving shape using the “point | side ids” dropdown. The selected point or side is highlighted in red in the drawing area.

Repeat the above steps for the fixed shape in the green section. Note that the fixed shape will be highlighted using green hatching in the drawing area.
Once you have entered valid data in the Snap Shapes dialog, the Snap button is enabled. Click on the button to perform the move action.

Merging Shapes

When creating sections from multiple shapes, you may want to merge various adjacent shapes to create a single shape. To do this, from the Toolbox, under the CAD and Data tab, under the CAD tab, click the Check for Merging Shapes... icon.
ShapeDesigner will then identify the various shapes that may be merged by comparing their relative distance to a tolerance value. If no shapes can be merged, you will get a warning message such as:

This indicates that the shapes are too distant and cannot be merged. To fix this problem, use the Snap Shapes tools.

If some shapes can be merged, the Merge Shapes dialog will be displayed. It will show the various merge combinations. Select the combination you want to merge in the list and click the Merge button to merge the shapes.

Note that the list displays all the shapes combinations that may be geometrically merged. If you try to merge shapes with different materials, you will get the warning:
When you click OK on this error, the **Material Properties** dialog is conveniently displayed for you to change one of the shape’s material.

The merged result of previous example looks like this:

---

**Deleting Points**

To delete a point, select the shape on which the point resides and from the **CAD and Data** tab of the toolbox select the **Geometry Edit** sub tab. Select a point by clicking in the point list. The selected point is highlighted in yellow in the drawing area. Click the delete button.
Modifying Shapes (Moving Points) Accurately

To modify the nodal coordinates of a shape, select a shape and from the CAD and Data tab of the toolbox, click the Geometry Edit tab or from the Shape | Properties menu select the Geometry… option. Select a point by clicking in the point list. The selected point is highlighted in yellow in the drawing area. You may modify the point coordinates. Your changes are updated immediately in the drawing area.

Generating Shapes

To repeat a shape pattern, from the CAD and Data tab of the toolbox, click on Generate Shape or from the Shape menu click Generate. The Shape Generation dialog is displayed. Select the type of generation: Translation or Rotation. If Translation is selected, set the translation parameters (see the “Moving Shapes Accurately” section). The dx and dy values indicate the offset between each generated shape. The Align to Centroid checkbox is used to compute the dx and dy values that would position the centroid of the first generated shape on the X-Y Origin. Select the shape to be copied using the horizontal scrollbar. Select the number of copies using the horizontal scrollbar. Click on Copy to generate the shapes. If you click Copy again, the generation continues from the last generated shape. Click Exit when you are done.
If Rotation is selected, set the rotation parameters. (see the “Rotating Shapes” section). Note that Number of Copies is ignored and assumed to be one if the selected rotation is anything but Free Rotation. Click on Copy to generate the shapes. If you click Copy again, the generation continues from the last generated shape.

Note that all generations done in the Shape Generation dialog are done in a single transaction and may be undone using the Edit menu and clicking Undo.

Refreshing the Drawing Area

To refresh the drawing area, click on the Refresh the Drawing Area icon in the toolbar.
License Status Description

With ShapeDesigner SaaS you can subscribe to one of three existing licenses.

1. **Professional Unlimited License**: this is a yearly professional subscription license with unlimited calculation and modeling.

2. **Professional Floating License**: this is a yearly professional subscription floating license with unlimited calculation and modeling. If the floating license is already in use and you sign in with the same floating license account in another computer, the license status will appear as trial license.

3. **Free Trial License**: this is a free trial subscription license with limited calculation and modeling. User can compute section properties for sections with maximum 2 shapes and 12 points.

Adding Labels to Shapes (Notes)

To add labels to shapes, select the shape to which you want to add a label. From the Shape menu select the Properties | Label Property… option. The Set Shape Label dialog appears. Enter a textual label then click OK.
To display labels, from the Dimensions tab of the main toolbox, click the View Shape Labels icon or from the View menu select the Shape Labels option.

**Dimensioning Shapes**

To view dimensions, from the Dimensions tab of the main toolbox, click the View Dimensions icon or from the View menu click the Dimensions option.

To dimension shapes, from the Dimensions tab of the main toolbox, click one of the three dimension type icons: **Horizontal**, **Vertical** and **Oblique**. ShapeDesigner™ switches to Dimension Definition Mode. Move the pointer over the first vertex point to dimension. When the point is selectable, a small green circle appears around the point. Click on the left mouse button to select the point. Repeat the previous steps for the second vertex point. When the second vertex is selected, the dimension is displayed and it follows the pointer. Position the dimension with the pointer and click the left mouse button to lock it in place.

When you are done dimensioning, click the right mouse button (or double click the left one) to exit Dimension Definition Mode.

When dealing with shapes with horizontal and vertical lines, selecting the correct dimension orientation type (horizontal, vertical and oblique) can be confusing at first. Generally, you should...
use the “oblique” type by default. Oblique dimensions are preserved when a shape is rotated. Horizontal and vertical dimensions adjust and change under such transformations.

It is important to set dimensions when dealing with composite sections to view the transformed dimensions when viewing the transformed composite section.

Editing Shape Dimensions

To move dimensions, click on the Edit Dimensions icon of the Dimensions tab of the toolbox. ShapeDesigner™ switches to Dimension Editing Mode. Select the dimension from the drawing area by clicking and holding left mouse button down on a dimension. The selected dimension turns red. Move dimension to the desired position. Release the left mouse button to lock the dimension in place. Click on the right mouse button to cancel the operation.

More dimension editing options are available from the dimension menu. In the main toolbox, select the Dimensions tab and from the dimension browser select the desired dimension and press the right mouse button to display the dimension menu.

The Delete this dimension and Delete all menu options allows you to delete the dimension(s). The Horizontal, Vertical and Oblique menu options allow you to change the dimension orientation.

The Set Label option allows you to change the label name. The default name is “L” followed by a sequential number.
Saving a Section Project File

To save a section to a file, on the toolbar click the Save Project icon or from the File menu select the Save Project option. The default file extension for ShapeDesigner™ is SHD. If this is the first time the file is saved, the File menu Save As dialog will be displayed.

Exporting Shapes to Other Applications

ShapeDesigner™ exports files using the DXF format. This is the most popular CAD file format. To save a section file in a DXF format, From the File menu click Export | to DXF. The current section project filename suffixed with a DXF extension will be used as the exported file filename. Saving sections you use regularly as DXF in a selected directory allows you to build a custom library of shapes.

ShapeDesigner™ can also save a snapshot of the drawing area to a bitmap using the File menu Export | to BMP. The current section project filename suffixed with a bmp extension will be used as the exported file filename.

Setting the Applied Loads

The final step before performing section analysis is to specify loads applied to the section. If you are not performing section analysis but only computing geometric properties, you may skip this step as ShapeDesigner™ assigns default unit load values to certain fields. Basically, ShapeDesigner™ requires these loads so that certain computation such as finding the neutral axis may be performed. By default, ShapeDesigner™ assigns a unit load to the moment (Mx), the torque, the bimoment and shear Vx and Vy. You may modify these values but ShapeDesigner™ will not let you proceed to the computation step if you have not specified a moment (either Mx, My or an axial load that is not located at x=0, y=0).

To set loads, in the Drawing and Data tab, from the Analysis menu select the Input Applied Loads… option. Enter the loads in the various tabs then click the OK button.
Meshing and Computing Geometric Properties

To compute geometric properties, from Analysis menu select the Mesh & Computing... option or click Mesh & Computing tab or press the F5 key.

Both selections are equivalent to the F5 key.
ShapeDesigner™ will check the section geometry and give an error message if the geometry is not acceptable for computing geometric properties. Some of the common reasons that may prevent your section from being computed are:

1) A hole extends outside its containing shape.
2) The section is made up of shapes that are not connected together (see tips to handle this).
3) A shape contains an invalid boundary.
4) The area of a shape is zero.
5) …

The applied loads will also be checks to ensure the required values are set. Access to the **Mesh & Computing** Tab is only granted if the geometry and loads are acceptable.

**Changing the Mesh Density**

Once the **Mesh & Computing** Tab is displayed, you can change the mesh density before proceeding to the property computations. If the “Automatic Optimal Calculation” checkbox is set, ShapeDesigner™ will automatically find a good mesh density for your section. This is the preferred method for simple sections. Note that the mesh is used to compute the torsion (J) and warping (Cw) constant only. Other properties do not require a mesh.

If you notice that the mesh density is inadequate for your section, uncheck the “Automatic Optimal Calculation” checkbox. ShapeDesigner™ displays the **Scroll Mesh Density** scrollbar to increase or decrease the mesh density. Move the **Scroll Mesh Density** scrollbar and click the **Mesh Section** button to view the new mesh. Repeat these two steps until you are satisfied with the mesh density.

*To obtain precise values of warping (Cw) and torsion (J) constants, the mesh must be uniformly distributed and have an adequate density.*
Linking Common Shape Boundaries Together

Before proceeding to the meshing phase, ShapeDesigner™ eliminates common boundaries by linking them if they fall within a tolerance distance (ε).

The tolerance distance is compared to the distance α between two points (or point and side) from two shapes. If the distance α is less than ε the two shapes are linked by merging the two points (or by merging the point and the equivalent position in the adjacent side).

The tolerance distance is specified in the Preference dialog in the General category in the Mesh & FEA Parameters.
Checking Common Boundary Linking

When designing build up sections, it is important to check the generated mesh to ensure that it is continuous over boundaries that should be “linked” and discontinuous over boundaries that should not. For example, in the following example, a section is build from three shapes. The top rectangle falls within the tolerance value while the right rectangle doesn’t. This leads to invalid results as shown on the stress view on the right.

There are a few ways to detect these problems. You can visually detect discontinuities (shapes that are not linked together) along the border by closely examining the mesh.

1) Clicking on an element will display its number, nodes ids and material. If elements on both side of the common boundary have 2 identical nodes, then they are linked. This is shown in image 1 below.

2) Visually, you may observe discontinuities at the border. This indicates an unlinked border. In image 2 below, which is a zoomed view of the previous mesh, two discontinuities (circled in yellow) are detected along the border (shown in red).

3) If you display node Ids, as in the image 3 below, and two node Ids appear at the same position, then you have a discontinuity.

4) If you zoom in on a region and see the two shapes. This is shown in image 4 which is a zoomed view of image 3.
Linking of common boundaries may occur with a single shape. For example, the following C shape common boundary is merged which is probably not the user’s intent. The results show the differences between a linked and an unlinked border.

The best way to fix a border continuity/discontinuity problem is to:
1) If only one shape is involved, edit the shape and move the border. This is normally done by going to the Drawing and Data tab, selecting the CAD and Data tab in the main toolbox and then selecting the Geometry Edit tab.
2) If two shapes are involved and you want to link the shape borders, select the shape to move and from the Shape menu, select the Snap Shape... option.

**Printing the Mesh**

If you want to print the mesh, from the Mesh menu select the Print... option. The mesh will be printed using the same parameters as those specified in the Mesh & Computing tab. Those parameters are Show/hide axes, Show/hide node ids, Show/hide element Ids, Show/hide material colors.
Section Properties and Stresses Analysis - Mesh

Mesh of the Section - Total Number of Elements: 2600; Total Number of Nodes: 1781
Computing Properties

When the mesh is correct, click the Compute Section Properties button or from the Compute menu select Compute Section Properties... ShapeDesigner™ computes the properties and when done switches from the Mesh & Computing tab to Results tab.

Viewing results

In the Results tab you may:
1) View, save and print tabular results.
2) Perform computations on different coordinate axes.
3) Perform section analysis with different load cases.
4) View and print graphical results.

Result windows are displayed and new menus are available.

Numerical results are displayed in the left portion of the screen under three tabs: Axes Properties, Custom and General.
1) The **General** tab contains general section properties.
2) The **Axes Properties** tab contains section properties with respect to the four standard coordinate systems.
3) The **Custom** tab contains section properties with respect to a user-defined position.

Graphical results selected from the **View Toolbox** are displayed in the **View Area**

**Changing Number Format**

From the Option menu select the Number Format… option.

**The General Tab**

The General tab contains various section properties, calculated values and the loads applied to obtain these values.

![Table of General Tab properties](image)
The Axes Properties Tab

The Axes Properties tab contains section properties with respect to the four standard coordinate systems:

1) The X-Y coordinates (white)
2) the centroid axes (blue)
3) the principal axes u-v (green)
4) the elastic neutral axes (red)

Each category may be collapsed (-) or expanded (+).

To view a graphical representation of the four coordinate systems, in the View Toolbox, select the Axes tab. Check the required axes and they will be displayed in the Axis View in the View Area.

1) The centroid is a small blue circle identified by the letter C.
2) The principal axes are shown in green and identified by the letters u and v.
3) The elastic neutral axis (ENA) is shown in red.
4) The shear center is small gray circle identified by the letter S. Its x and y distance from the centroid is displayed if the “Shear/Centroid label” is checked.
5) The plastic neutral axis (PNA) is shown in turquoise. (Not shown here)
6) The custom axes are shown in purple and identified by the letters XA and YA (not shown here. see the “Custom tab” section)

The “View Extreme Fibers” highlights the position that is the most distant from the selected axes system (principal, centroid, neutral).
The Custom Tab

The Custom tab is used to compute section properties with respect to a user-defined point (A).

Performing Computations on Different Coordinate Axes

You may compute section properties with respect to a user-defined point (A). To do this, enter the X and Y value of the point’s position and press the Compute button. Another way of selecting the point’s position is to check the Custom position by Mouse checkbox and click on the position in the view area. Clicking on the mouse automatically sets the X and Y values and applies the Compute button. If the View Custom Axes of the Axes tab of the View Toolbox checkbox is checked, the custom axes are displayed in purple in the view area.

The custom axes properties are updated automatically. If the selected point “A” falls inside the section, the Custom Point Stresses values are also updated.

The Failure Criteria for Yield Strength tree evaluates various criteria at point “A” and displays a green check if the criterion is satisfied or a red X is otherwise.

Some of the properties are also displayed in the status bar.
**Viewing Stress Distributions**

Using the **Stresses** tab of the **View Toolbox**, you may view a graphical representation of the Axial, X-Shear and Y-Shear stress distribution and of the X and Y shear flow distribution. Other graphical results are available in the **Advanced** tab.

To view one of the three stress distributions, select the corresponding checkbox then, in the view area, press and keep the mouse button down. The distribution axis will be displayed. Move the mouse to position the distribution axis and release the button when it is at the correct position.

Perform the same operations to view the two shear flows. In this case, the position of the distribution axis does not influence the results displayed.

**Viewing Maximum Stresses**

In the **Max/Min Stress** tab of the **Stresses** tab, the minimum and maximum stresses and position is displayed. Expand the tree node to see the position.

**Viewing Stress or Shear Flow at a Specific position**

To view stress or shear flow at a specific position, select the **Selected Stresses** tab and right click in the view area.
Viewing various Stresses as Iso-Colors

From the Advanced tab of the View Toolbox, Select the Stress distribution to display. The following 16 options are available:

1) Bending
2) Warping
3) Bending and warping resultant
4) Von-Mises
5) Principal Sigma I
6) Principal Sigma II
7) Tau Max
8) Torsional (tau xz, tau yz, tau)
9) Shear (tau xz, tau yz, tau)
10) Total Shear (tau xz, tau yz, tau)
Saving Tabular Results

The data contained in the Results tab may be saved to disk using the Results menu’s Save Tabular Result to ASCII file option. This saves the data as a simple ASCII file using the name of the section project and the .out extension as filename. The file is overwritten without warning.

Printing results

To generate a PDF report, in the Results tab, in the results menu select the Print Graphical Results… option. The following dialog is displayed for you to select the content of the PDF report.

The Print Drawing Section Geometry option will print the content of the view area as displayed when the Axis tab of the View toolbox is selected. Select the elements (centroid, principal axes…) you want to appear in the printed report (see “The Axes Properties Tab” section above) from the Axis tab before printing.

The Print Calculated Geometric Properties option will print the numerical results of the section properties.

The Print Isovalues Axial and Equivalent Stresses and Print Isovalues Shear Stresses option will print a printer friendly representation of the specified stresses.

The following pages show a typical report.
### Description of the Calculated Properties

#### General Properties

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Total area</td>
</tr>
<tr>
<td>Transf.Area</td>
<td>Transformed composite area</td>
</tr>
<tr>
<td>Mass/L</td>
<td>Total mass/unit length</td>
</tr>
<tr>
<td>Xc</td>
<td>Centroid X position</td>
</tr>
<tr>
<td>Yc</td>
<td>Centroid Y position</td>
</tr>
<tr>
<td>NA (Deg)</td>
<td>Elastic neutral axis angle</td>
</tr>
<tr>
<td>PNA (x,y)</td>
<td>Plastic neutral axis position</td>
</tr>
<tr>
<td>Bx(Stability)</td>
<td>X Stability constant</td>
</tr>
<tr>
<td>By(Stability)</td>
<td>Y Stability constant</td>
</tr>
</tbody>
</table>

#### Torsion and Warping Properties

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J(Torsion)</td>
<td>Torsion constant</td>
</tr>
<tr>
<td>Cw(Warping)</td>
<td>Warping constant</td>
</tr>
<tr>
<td>Xs (Shear)</td>
<td>X position of the Shear center</td>
</tr>
<tr>
<td>Ys (Shear)</td>
<td>Y position of the Shear center</td>
</tr>
<tr>
<td>Ax</td>
<td>X Shear reduced area</td>
</tr>
<tr>
<td>Kx</td>
<td>X Shear section constant</td>
</tr>
<tr>
<td>Ay</td>
<td>Y Shear reduced area</td>
</tr>
<tr>
<td>Ky</td>
<td>Y Shear section constant</td>
</tr>
<tr>
<td>Ios</td>
<td>Moment of inertia about shear center</td>
</tr>
<tr>
<td>ros</td>
<td>Radius of gyration about shear center</td>
</tr>
<tr>
<td>Swx</td>
<td>X Sectorial Product of Area</td>
</tr>
<tr>
<td>Swy</td>
<td>Y Sectorial Product of Area</td>
</tr>
<tr>
<td>Dsc</td>
<td>Distance between shear center and centroid</td>
</tr>
<tr>
<td>Btorsional-flexural constant</td>
<td>Torsional-flexural constant</td>
</tr>
</tbody>
</table>

#### Composite section Properties

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elastic modulus of the material of reference</td>
<td>Centroid X position in transformed composite section</td>
</tr>
<tr>
<td>Centroid Y position in transformed composite section</td>
<td></td>
</tr>
</tbody>
</table>

#### Stresses Properties

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sig-yield T</td>
<td>Tensile stress yield</td>
</tr>
<tr>
<td>Sig-yield C</td>
<td>Compressive stress yield</td>
</tr>
<tr>
<td>Tau yield</td>
<td>Shear Stress yield tau</td>
</tr>
<tr>
<td>Sig-x max T)</td>
<td>Maximum Tensile stress</td>
</tr>
<tr>
<td>Sig-x max C)</td>
<td>Maximum Compressive stress</td>
</tr>
<tr>
<td>Fpt</td>
<td>Maximum Tensile Force related to plastic stress block</td>
</tr>
<tr>
<td>Fpc</td>
<td>Maximum Compressive Force related to plastic stress block</td>
</tr>
<tr>
<td>Np Column Capacity</td>
<td>Axial capacity for column</td>
</tr>
</tbody>
</table>

#### Loads Properties

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied moment about x axis</td>
<td>Moment Mx</td>
</tr>
<tr>
<td>Applied moment about y axis</td>
<td>Moment My</td>
</tr>
<tr>
<td>Applied axial load</td>
<td>Axial N</td>
</tr>
</tbody>
</table>
### Axes X-Y Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I_x$</td>
<td>Moment of inertia about x axis</td>
</tr>
<tr>
<td>$I_y$</td>
<td>Moment of inertia about y axis</td>
</tr>
<tr>
<td>$I_{xy}$</td>
<td>Product of inertia about x-y axes origin</td>
</tr>
<tr>
<td>$I_o$</td>
<td>Polar moment of inertia about x-y centroidal axes origin</td>
</tr>
<tr>
<td>$r_x$</td>
<td>Radius of gyration about x axes origin</td>
</tr>
<tr>
<td>$r_y$</td>
<td>Radius of gyration about y axes origin</td>
</tr>
<tr>
<td>$r_o$</td>
<td>Radius of gyration about x-y axes origin</td>
</tr>
</tbody>
</table>

### Centroidal Axes Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I_x$</td>
<td>Moment of inertia about x centroidal axis</td>
</tr>
<tr>
<td>$I_y$</td>
<td>Moment of inertia about y centroidal axis</td>
</tr>
<tr>
<td>$I_{xy}$</td>
<td>Product of inertia about x-y centroidal axes origin</td>
</tr>
<tr>
<td>$I_o$</td>
<td>Polar moment of inertia about x-y centroidal axes origin</td>
</tr>
<tr>
<td>$r_x$</td>
<td>Radius of gyration about x centroidal axis</td>
</tr>
<tr>
<td>$r_y$</td>
<td>Radius of gyration about y centroidal axis</td>
</tr>
<tr>
<td>$r_o$</td>
<td>Radius of gyration about x-y centroidal axes origin</td>
</tr>
<tr>
<td>$y_{top}$</td>
<td>Extreme top fiber from x centroidal axis</td>
</tr>
<tr>
<td>$y_{bot}$</td>
<td>Extreme bottom fiber from x centroidal axis</td>
</tr>
<tr>
<td>$S_x_{top}$</td>
<td>Elastic section modulus about x centroidal axis related to the top fiber</td>
</tr>
<tr>
<td>$S_x_{bot}$</td>
<td>Elastic section modulus about x centroidal axis related to the bottom fiber</td>
</tr>
<tr>
<td>$x_{right}$</td>
<td>Extreme right fiber from y centroidal axis</td>
</tr>
<tr>
<td>$x_{left}$</td>
<td>Extreme left fiber from y centroidal axis</td>
</tr>
<tr>
<td>$S_y_{right}$</td>
<td>Elastic section modulus about y centroidal axis related to the right fiber</td>
</tr>
<tr>
<td>$S_y_{left}$</td>
<td>Elastic section modulus about y centroidal axis related to the left fiber</td>
</tr>
<tr>
<td>$Z_{px}$</td>
<td>Plastic section modulus about x centroidal axis</td>
</tr>
<tr>
<td>$Z_{py}$</td>
<td>Plastic section modulus about y centroidal axis</td>
</tr>
<tr>
<td>$Max,M_x$</td>
<td>Maximum elastic moment about x centroidal axis</td>
</tr>
<tr>
<td>$Max,M_y$</td>
<td>Maximum elastic moment about y centroidal axis</td>
</tr>
<tr>
<td>$M_{px}$</td>
<td>Fully plastic moment about x centroidal axis</td>
</tr>
<tr>
<td>$M_{py}$</td>
<td>Fully plastic moment about y centroidal axis</td>
</tr>
<tr>
<td>$SF_x$</td>
<td>Shape factor about x centroidal axis</td>
</tr>
<tr>
<td>$SF_y$</td>
<td>Shape factor about y centroidal axis</td>
</tr>
</tbody>
</table>
### Principal Axes Properties

<table>
<thead>
<tr>
<th>Description</th>
<th>Principal Axes Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ix</td>
<td>Moment of inertia about x principal axis</td>
</tr>
<tr>
<td>Iy</td>
<td>Moment of inertia about y principal axis</td>
</tr>
<tr>
<td>Ixy</td>
<td>Product of inertia about x-y principal axes origin</td>
</tr>
<tr>
<td>Io</td>
<td>Polar moment of inertia about x-y principal axes origin</td>
</tr>
<tr>
<td>rx</td>
<td>Radius of gyration about x principal axis</td>
</tr>
<tr>
<td>ry</td>
<td>Radius of gyration about y principal axis</td>
</tr>
<tr>
<td>ro</td>
<td>Radius of gyration about x-y principal axes origin</td>
</tr>
<tr>
<td>IMax</td>
<td>Maximum magnitudes of principal moment of inertia</td>
</tr>
<tr>
<td>IMin</td>
<td>Minimum magnitudes of principal moment of inertia</td>
</tr>
<tr>
<td>Theta (Deg)</td>
<td>Angle of orientation between the principal x-axis and x-axis</td>
</tr>
<tr>
<td>Y top</td>
<td>Extreme top fiber from x principal axis</td>
</tr>
<tr>
<td>Y bot</td>
<td>Extreme bottom fiber from x principal axis</td>
</tr>
<tr>
<td>Sx top</td>
<td>Elastic section modulus about x principal axis related to the top fiber</td>
</tr>
<tr>
<td>Sx bot</td>
<td>Elastic section modulus about x principal axis related to the bottom fiber</td>
</tr>
<tr>
<td>X right</td>
<td>Extreme right fiber from y principal axis</td>
</tr>
<tr>
<td>X left</td>
<td>Extreme left fiber from y principal axis</td>
</tr>
<tr>
<td>Sy right</td>
<td>Elastic section modulus about y principal axis related to the right fiber</td>
</tr>
<tr>
<td>Sy left</td>
<td>Elastic section modulus about y principal axis related to the left fiber</td>
</tr>
<tr>
<td>Zpx</td>
<td>Plastic section modulus about x principal axis</td>
</tr>
<tr>
<td>Zpy</td>
<td>Plastic section modulus about y principal axis</td>
</tr>
<tr>
<td>Max Mx</td>
<td>Maximum elastic moment about x principal axis</td>
</tr>
<tr>
<td>Max My</td>
<td>Maximum elastic moment about y principal axis</td>
</tr>
<tr>
<td>Mpx</td>
<td>Fully plastic moment about x principal axis</td>
</tr>
<tr>
<td>Mpy</td>
<td>Fully plastic moment about y principal axis</td>
</tr>
<tr>
<td>SFx</td>
<td>Shape factor about x principal axis</td>
</tr>
<tr>
<td>SFy</td>
<td>Shape factor about y principal axis</td>
</tr>
</tbody>
</table>

### Elastic Neutral Axis Properties

<table>
<thead>
<tr>
<th>Description</th>
<th>Elastic Neutral Axis Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>In</td>
<td>Moment of inertia about neutral axis</td>
</tr>
<tr>
<td>ENA Angle(°)</td>
<td>Angle of orientation of the neutral axis from x-axis</td>
</tr>
<tr>
<td>Y top</td>
<td>Extreme top fiber from neutral axis</td>
</tr>
<tr>
<td>Y bot</td>
<td>Extreme bottom fiber from neutral axis</td>
</tr>
<tr>
<td>Sx top</td>
<td>Elastic section modulus about neutral axis related to the top fiber</td>
</tr>
<tr>
<td>Sx bot</td>
<td>Elastic section modulus about neutral axis related to the top fiber</td>
</tr>
<tr>
<td>X right</td>
<td>Extreme right fiber from perpendicular neutral axis</td>
</tr>
<tr>
<td>X left</td>
<td>Extreme left fiber from perpendicular neutral axis</td>
</tr>
<tr>
<td>Sy right</td>
<td>Elastic section modulus about perpendicular neutral axis related to the right fiber</td>
</tr>
<tr>
<td>Sy left</td>
<td>Elastic section modulus about perpendicular neutral axis related to the left fiber</td>
</tr>
<tr>
<td>Zpx</td>
<td>Plastic section modulus about x neutral axis</td>
</tr>
<tr>
<td>Zpy</td>
<td>Plastic section modulus about perpendicular neutral axis</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Max Mx</td>
<td>Maximum elastic moment about x neutral axis</td>
</tr>
<tr>
<td>Max My</td>
<td>Maximum elastic moment about perpendicular neutral axis</td>
</tr>
<tr>
<td>Mpx</td>
<td>Fully plastic moment about x neutral axis</td>
</tr>
<tr>
<td>Mpy</td>
<td>Fully plastic moment about perpendicular neutral axis</td>
</tr>
<tr>
<td>SFx</td>
<td>Shape factor about x neutral axis</td>
</tr>
<tr>
<td>SFy</td>
<td>Shape factor about perpendicular neutral axis</td>
</tr>
<tr>
<td>Torque Max</td>
<td>Maximum elastic torque</td>
</tr>
<tr>
<td>Txs max</td>
<td>Maximum Shear stress Txs due to shear load Vx</td>
</tr>
<tr>
<td>Tsy max</td>
<td>Maximum Shear stress Tsy due to shear load Vy</td>
</tr>
</tbody>
</table>

**Maximum Positive and Negative Stresses Description**

- sx: Axial stress
- sw: Axial warping stress
- tsx: Shear stress in x direction
- tsy: Shear stress in y direction
- txz: Torsional shear stress in x direction
- tyz: Torsional shear stress in y direction

**Stresses at Custom Position Description**

- sx: Axial stress
- sw: Axial warping stress
- tsx: Shear stress in x direction
- tsy: Shear stress in y direction
- txz: Torsional shear stress in x direction
- tyz: Torsional shear stress in y direction
- qx: Flow stress in x direction
- qy: Flow stress in y direction
- sI ; sII ; sIII: Principal stresses

**Failure criteria for yield strength**

- Maximum normal stress criterion
- Tresca criterion
- Von Mises-Hencky criterion
- Saint-Venant criterion
- Maximum strain energy criterion
Multi-Project Script

The multi-project script is useful when you want to compare many sections with different materials and dimensions or when you simply want to generate reports with many projects.

Starting à Multi-Project Script

From the File menu, select the Open Project... option to view the “Starting a Project” window. Select the Multi-Project Script button. You will then switch to Multi-Project mode and an empty script will automatically be created.
The Multi-Project Script Window Mode

In multi-project mode, you can calculate properties for many previously prepared sections. You can load existing script project (files with .SCP extension) or create a new script project by adding ShapeDesigner™ project (files with .SHD extension).

Adding a ShapeDesigner™ Project to the Multi-Project Script

To add a ShapeDesigner™ project to the script, press the add icon (+) in the action column. The file open dialog is displayed. Browse and select the ShapeDesigner™ project file to add to the script.

Removing a ShapeDesigner™ Project from the Multi-Project Script

To remove a project from the script, press the remove icon (x) in the action column.
Viewing the Project Section

When you click on the project name in the left pane, the section is displayed in the view area. See image below.

Saving the Multi-Project Script

To save a script, from the File menu select the Save option. The script name appears in the left pane.

Running the Multi-Project Script

To run the script and compute all sections, from the File menu, select the Run option or click on the Run Script icon. The progress bar will show the script’s execution point. As the projects are calculated, a green check is added in the status column. The view area displays the section properties as they are calculated.

Excluding Sections from the Script

To exclude sections from the script, uncheck the blue checkbox next to the project name.

Printing the Multi-Project Script Results

From the File menu, select the Print... option. A PDF report is generated.

© MECHATOOLS TECHNOLOGIES INC. 2010
## Example of PDF Report of Multi-Project Script

<table>
<thead>
<tr>
<th>Project</th>
<th>CRAG-6.1/G1061</th>
<th>TEST-2/4D</th>
<th>SECTION3</th>
<th>SECTION2-V564</th>
<th>25-RUBBER1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>+10.03E+00 mm</td>
<td>+27.90E+00 in</td>
<td>+41.22E+00 mm</td>
<td>+41.32E+00 mm</td>
<td>+35.94E-01 cm</td>
</tr>
<tr>
<td>Height</td>
<td>+20.02E+00 mm</td>
<td>+24.50E+00 in</td>
<td>+72.60E+00 mm</td>
<td>+77.02E+00 mm</td>
<td>+21.60E-01 cm</td>
</tr>
<tr>
<td>Area</td>
<td>+63.75E+00 mm²</td>
<td>+16.50E+00 in²</td>
<td>+34.30E+00 mm²</td>
<td>+47.65E+00 mm²</td>
<td>+41.21E-01 cm²</td>
</tr>
<tr>
<td>Transl.</td>
<td>+63.75E+00 mm²</td>
<td>+16.50E+00 in²</td>
<td>+34.30E+00 mm²</td>
<td>+47.65E+00 mm²</td>
<td>+41.21E-01 cm²</td>
</tr>
<tr>
<td>Wmin</td>
<td>+20.02E+00 mm</td>
<td>+11.42E+00 in</td>
<td>+31.25E-05 kg/ mm</td>
<td>+56.58E+00 kg/ mm</td>
<td>+34.21E+00 kg/ cm</td>
</tr>
<tr>
<td>Xc</td>
<td>+24.13E+00 mm</td>
<td>+55.06E-05 in</td>
<td>+11.72E+04 mm</td>
<td>+18.84E+00 mm</td>
<td>+16.85E-07 cm</td>
</tr>
<tr>
<td>Yc</td>
<td>+56.13E+00 mm</td>
<td>+99.12E-06 in</td>
<td>+6.51E+04 mm</td>
<td>+14.14E+00 mm</td>
<td>+15.78E+00 cm</td>
</tr>
<tr>
<td>Torsion &amp; Shear</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>U(Torsion)</td>
<td>+11.22E+00 mm²</td>
<td>+14.64E+00 in²</td>
<td>+18.86E-04 mm²</td>
<td>+17.26E+00 mm²</td>
<td>+20.66E-01 cm²</td>
</tr>
<tr>
<td>Cw(Warping)</td>
<td>+28.58E+00 mm</td>
<td>+1.15E+05 in</td>
<td>+22.52E+00 mm</td>
<td>+22.65E+00 mm</td>
<td>+12.67E+00 cm</td>
</tr>
<tr>
<td>Xs (Shear)</td>
<td>+11.22E+00 mm</td>
<td>+7.33E+00 in</td>
<td>+7.34E+00 mm</td>
<td>+9.81E+00 mm</td>
<td>+11.65E+00 cm</td>
</tr>
<tr>
<td>Ys (Shear)</td>
<td>+25.01E+00 mm</td>
<td>+3.87E+00 in</td>
<td>+4.79E+00 mm</td>
<td>+5.70E+00 mm</td>
<td>+23.59E+00 cm</td>
</tr>
<tr>
<td>Ax</td>
<td>+11.34E+00 mm²</td>
<td>+18.72E+00 in²</td>
<td>+23.05E+00 mm²</td>
<td>+26.73E+00 mm²</td>
<td>+45.64E-01 cm²</td>
</tr>
<tr>
<td>Kx</td>
<td>+11.34E+00 mm²</td>
<td>+18.72E+00 in²</td>
<td>+23.05E+00 mm²</td>
<td>+26.73E+00 mm²</td>
<td>+45.64E-01 cm²</td>
</tr>
<tr>
<td>Ay</td>
<td>+28.58E+00 mm</td>
<td>+1.15E+05 in</td>
<td>+22.52E+00 mm</td>
<td>+22.65E+00 mm</td>
<td>+12.67E+00 cm</td>
</tr>
<tr>
<td>Ky</td>
<td>+31.71E+00 mm</td>
<td>+7.33E+00 in</td>
<td>+7.34E+00 mm</td>
<td>+9.81E+00 mm</td>
<td>+11.65E+00 cm</td>
</tr>
<tr>
<td>Centroid Axes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ix</td>
<td>+27.22E+00 mm²</td>
<td>+12.21E+03 in²</td>
<td>+19.87E+04 mm²</td>
<td>+44.17E+04 mm²</td>
<td>+81.65E+01 cm²</td>
</tr>
<tr>
<td>iy</td>
<td>+45.48E+05 mm²</td>
<td>+28.92E+03 in²</td>
<td>+66.00E+04 mm²</td>
<td>+127.46E+04 mm²</td>
<td>+24.89E+01 cm²</td>
</tr>
<tr>
<td>kx</td>
<td>+85.61E+05 mm²</td>
<td>+56.53E+02 in²</td>
<td>+90.66E+01 mm²</td>
<td>+141.47E+01 mm²</td>
<td>+90.63E+00 cm²</td>
</tr>
<tr>
<td>Iy</td>
<td>+31.71E+00 mm²</td>
<td>+12.21E+03 in²</td>
<td>+19.87E+04 mm²</td>
<td>+44.17E+04 mm²</td>
<td>+81.65E+01 cm²</td>
</tr>
<tr>
<td>r1</td>
<td>+27.22E+00 mm²</td>
<td>+12.21E+03 in²</td>
<td>+19.87E+04 mm²</td>
<td>+44.17E+04 mm²</td>
<td>+81.65E+01 cm²</td>
</tr>
<tr>
<td>r2</td>
<td>+45.48E+05 mm²</td>
<td>+28.92E+03 in²</td>
<td>+66.00E+04 mm²</td>
<td>+127.46E+04 mm²</td>
<td>+24.89E+01 cm²</td>
</tr>
<tr>
<td>r3</td>
<td>+85.61E+05 mm²</td>
<td>+56.53E+02 in²</td>
<td>+90.66E+01 mm²</td>
<td>+141.47E+01 mm²</td>
<td>+90.63E+00 cm²</td>
</tr>
<tr>
<td>Ytop</td>
<td>+11.34E+00 mm</td>
<td>+7.33E+00 in</td>
<td>+7.34E+00 mm</td>
<td>+9.81E+00 mm</td>
<td>+11.65E+00 cm</td>
</tr>
</tbody>
</table>

© MECHAT OOLS TECHNOLOGIES INC. 2010
Users of ShapeDesigner™ may use the icons on the toolbars to speed up access to some commonly used functions. Holding the pointer over an icon displays a tool tip describing the icon function.

Main Toolbar (main bar is rotate to -90 degrees)

- New Project
- Open Existing Project
- Save Project
- Switch to Multi-Project Script Mode
- Cut Shape
- Copy Shape
- Paste Shape
- Delete Shape
- Print Drawing Graphics
- Help
- Show and Hide Gridline
- Show and Hide Axes
- Show and Hide Point Ids
- Show and Hide Shape Ids
- Refresh graphics
- Show and Hide Material Colors
- Zoom in
- Zoom out
- Zoom Window
- Zoom All
- Set Bounding Box to fit All Shapes Inside It
- Zoom list
- Change Units
- Preferences
- Goto MechaTools Technologies Web Site
- Send email to MechaTools
Toolbox

The Toolbox contains icons that perform various operations. These icons are grouped by topics under tabs. For example, the **CAD and Data** tab contains icons used to manipulate geometries. Some of the toolbox icons do not have corresponding menu items.

The **Cross Section Input** tab contains operations to create shapes and holes, and operations to add shapes to the drawing area.

The **CAD and Data** tab is divided in three categories grouped under tabs. The first category, **CAD**, contains operations to modify existing shapes. The second category, **Geometry Edit**, contains operations to change the bounding box. The last category, **Properties**, is used display shape properties.
The **Dimensions** tab contains operations to visually document the section using dimensions, labels.

![Dimensions Tab Image]

The **Utilities** tab contains tools to perform unit conversion, calculator ...

![Utilities Tab Image]
Menus

ShapeDesigner™ uses standard Windows menu for File, Edit and Windows operations. It also has a range of menus for working with sections and groups of shapes. Menus are contextual and change depending on the currently selected tab.

File Menu (of the Drawing and Data tab)

The File menu contains commands for creating, opening and saving section project files. It also contains commands to print and export data.

New Project... (Ctrl + N)

Use New to start work on a new section project. If you have unsaved changes to the current section project, ShapeDesigner™ will prompt you to save your work before starting the new project.

Open Project... (Ctrl + O)

Use Open to open an existing section project. If you have any unsaved changes to the current section project, ShapeDesigner™ will prompt you to save your work before opening the section project.

Save Project (Ctrl + S)

Use Save to save the current section project.

Save Project As...

Use Save As to save the current section project to a new file.

Print...

Use Print to print the contents of the display area.

Import/Export

Use Export to export the current section project to a DXF file or to a bitmap file. The files are automatically created in the same directory as the section project file (SHD). The file name used is the file name of the section project except for the extensions (.BMP, .DXF). The bitmap file
contains a view of the current drawing area. The DXF file contains the section geometry. Use **Import** to insert (DXF File) a section from another application.

**Exit**

Use **Exit** to exit the application.

**Edit Menu (of the Drawing and Data tab)**

The Edit menu contains commands for copying and pasting tabular data, selecting objects and working in tables.

**Undo (Ctrl + Z)**

Undoes the last action carried out. **Undo** supports only one level of undo. When an action is undone, it may be redone using **Redo**.

**Redo (Ctrl + Y)**

Redoes the last undone action. When an action is redone, it may be undone using **Undo**.

**Cut (Ctrl + X)**

Remove the current selection and place it on the clipboard. (This info cannot be used outside the application)

**Copy (Ctrl + C)**

Copy the current selection to the clipboard
Paste (Ctrl + V)
Paste the contents of the clipboard into the current selection

Delete (Del)
Remove the current selection without placing it on the clipboard.

Options Menu (of the Drawing and Data tab)

Preferences...
Change the options to values that you would like to use for most shape that you will create in the future (ex comment, project number, company, client, colors, fonts etc...).

Change Bounding Box
Mouse
Scale the drawing in the drawing area so that it just fits inside the view window.

Manually
Set the maximum and minimum coordinates available in the drawing area. Use this to set up the overall coordinates before you begin drawing a section.

Change Units...
The Change Units dialog is used to select the units to be used by ShapeDesigner™ for all future operations. The Change Units dialog may be invoked at any time by:

1) Clicking the Change Units icon on the toolbar
2) From the Options menu by clicking Change Units … option.
3) From the Preferences dialog in the units category.

The Change Units dialog is automatically displayed when starting a new project if you have not previously checked the “Set as Default Units for Future Projects”. Note that changing units actually performs unit conversions when shapes are loaded. For example, a 1-inch edge becomes a 2.54 cm edge. Click the Apply button when you are done.

Units for the 4 types (length, mass, stress and load) may not be changed independently. For example, changing the length units from inches to millimeter will also automatically change the mass units to kilogram, the stress to mega Pascal etc.
You can use the selected units in the future projects by selecting on the “Set as Default Units for Future Projects” checkbox.

**View Menu**

The View menu contains commands for controlling the display of the drawing area.

**Points and Ids**

Turn on or off the display of point numbering of the shapes in the drawing area.

**Shapes Ids**

Turn on or off the display of shape numbering in the drawing area.

**Axes**

Turn on or off the display of axes in the drawing area.
Grid
Switch on or off the use of the grid in the drawing area and set the spacing of the grid.

Units...
Change the current units.

Zoom In
Zoom in on part of the current display by 10%.

Zoom Out
Zoom out on part of the current display by 10%.

Zoom Win
Zoom in on part of the current display selected using the mouse pointer. Press the mouse button and dragging a rectangle surrounding the area of interest. Release the button to zoom in on the selection.

Add (Horizontal, Vertical, Oblique) Dimension
Turn on for adding dimensions annotation in the drawing area.

View Dimensions
Turn on or off the display dimensions in the drawing area.

Shapes Labels
Turn on or off the display of shape labels in the drawing area.

Shape Menu
The Shape menu contains commands for working with shapes in the drawing area.
Modify...
Invokes the Geometry Edit tab of the CAD and Data tab of the main toolbox to edit the shape geometry.

Move
Moves the selected shape using the mouse pointer or the arrow keys.

Flip about X Centroid (Flip Horizontal)
It reflects the selected shapes about a vertical axis passing through origin or the centroid of the area of the selected shape.

Flip about Y Centroid (Flip Vertical)
It reflects the selected shapes about a horizontal axis passing through the origin or the centroid of the area of the selected shapes.

Align Shape Centroid to X-Y Origin
Aligns the selected shape’s centroid to the X-Y origin.

Aligns All Shape Centroid to X-Y Origin
Aligns the centroid of all shapes to the X-Y origin.

Generate... and Transform...
Invokes dialogs to generate new shapes from existing ones by translation, rotation ... operations are:
**Duplicate**
It duplicates the selected shape in the work area window a given number of times. In this case you can duplicate shape by rotation, flipping, scaling or translating.

**Rotate**
Rotates all or the selected shapes in the drawing window a specified number of degrees about the origin of the axes, the centroid or a specific point in the selected shape. A dialog allows you to enter the number of degrees of rotation. Rotation is positive anti-clockwise.

**Rotate Right**
Rotates all or the selected shapes in a 90 degrees about the origin of the axes or the centroid of each shape.

**Rotate Left**
Rotates all or the selected shapes in a -90 degrees about the origin of the axes or the centroid of each shape.

**Scale**
It multiplies the coordinates of the selected shape by a specified scaling factor in each axis direction.

**Translate**
Allows you to move the selected shapes a specified distance. This provides a more accurate way of moving shapes rather than dragging them with the mouse.

**Color**
Sets the material color of the selected shape.

**Delete**
Deletes the selected shape.

**Hatches...**
Invokes dialogs to select the hatch pattern.

**Properties/Geometry...**
Invokes the Geometry Edit tab of the CAD and Data tab of the main toolbox to edit the shape geometry.

**Properties/Material...**
Changes the material properties of the current shape.

**Properties/Label Property...**
Changes the label of the current shape.

**Add Hole**
Place hole from a custom or an existing shape from the Sections Library components into the selected Shape.

**Snap Shapes ...**
Moves to shapes relative to each other to assemble build up sections.
Add Hole

Place hole from a custom or an existing shape from the Sections Library components into the selected Shape.

View Selected Shape Dimensions

Turns on or off the display of dimensions.

View Selected Shape Automatic Dimensions

Turns on or off the display of automatic dimensions.

Analysis Menu

Mesh and Computing... F5

Moves to the Mesh & Computing tab to build the mesh.

Optimize Section...

Displays the Section Optimization dialog.

View Extruded Section...

View the section as a 3D extruded beam.
Input Applied Loads...

Displays the Applied Loads dialog to input loads for section analysis.

Help Menu

The Help menu contains commands for accessing ShapeDesigner’s on-line help system.

View My Account...

Takes you to the administrative account on the web.

Help... F1

Displays the help.

Interactive Help

Displays the interactive demos.
MechaTools Technologies on the Web
Takes you to the home or support page on the web.

About ShapeDesigner™
It displays version information for this version of ShapeDesigner™.
To quit ShapeDesigner™ press the exit button from the main Toolbar or from File menu select File | Exit then answer yes to confirm exit procedure, because ShapeDesigner™ asked to confirm if you are sure to quit program.

Mesh Menu

Mesh Section
Recomputes the mesh.

Print ...
Prints the mesh to a DXF file.

Compute Menu

Compute Section Properties F5
Computes the section properties and switches to the Results tab.

Input Applied Loads...
Displays the Applied Loads dialog to input loads for section analysis.

Option Menu (of the Mesh & Computing tab)

Preferences...
Change the options to values that you would like to use for most shape that you will create in the future (ex comment, project number, company, client, colors, fonts etc...).
Result Mode

When computations are done, ShapeDesigner™ switches from Mesh & Computing mode to Result mode. In this mode, new result windows and menus are displayed.

Results Menu

View Tabular Results...

In Result mode, the data contained in the Results dialog may be viewed in a tab delimited ASCII file.

Saving tabular results to ASCII File

Saves the data contained in the Results in a tab delimited ASCII file.

Printing Tabular Results

In Result mode, the data contained in the Results dialog may be printed using the Option menu Print Tabular Results option. Or from Results dialog press the view button and then print your file.

Printing Graphical Results...

In Results mode, the graphic currently displayed in the Axis View may be printed using the Results menu Print Graphical Results... or from Results toolbar by clicking on the print icon.

Option Menu (of the Results Tab)

Number Format...

Selects the number format for various reports.
Computing for Composite Section Analysis

Section Optimization (general sections)

The Section Optimization component is used to optimize the geometry boundaries in order to get a desired value of specific variable. The variables that we can use in the optimization process are:

- **A**: Area of the cross section
- **Ixc**: Moment of inertia about x axis through centroid
- **Iyc**: Moment of inertia about y axis through centroid
- **Ioc**: Polar moment of inertia about origin of the centroidal axes
- **Stx**: Elastic Modulus about x axis at top
- **Sbx**: Elastic Modulus about x axis at bottom
- **Sry**: Elastic Modulus about y axis at top
- **Sby**: Elastic Modulus about y axis at bottom
- **Zx**: Plastic Modulus about y axis
- **Zy**: Plastic Modulus about y axis
- **rx**: Radius of gyration about x axis
- **ry**: Radius of gyration about y axis
Example of section to be optimized:

From the list, select the variable to be optimized

Input the value of the selected variable

Select the boundaries to be respected in order to get (optimize) the desired variable value

The new boundaries

The list contains the new values in respect to new boundaries

The boundaries to be respected in order to get the desired variable value

The variables list, that can be used for optimize
From Compute menu (or in the drawing area press the right mouse button) then select **Optimize Section**…

Results mode in the Optimization Section Window:

From Compute menu (or in the bleu area press the right mouse button) then select **Optimize Section**…
Some examples are presented in the examples section at the end of this user guide.
Custom Design (Design verification)

The design of beams for specific applications is usually governed by detailed specifications and codes involving design requirements and procedures specific to each country.

In ShapeDesigner, you can verify your design by introducing your custom code equations. ShapeDesigner™ accept the mathematical input formulas to verify the design of your structure by applying the specified equations in a collection of criteria. Each criterion contains a mathematical equation that respects one criterion of the code design. With this approach, ShapeDesigner™ is a self-update design criteria code. If the country specification code changes, you can do it with the same ShapeDesigner™ version without updating or purchasing a new version. In the Results mode window select the Design tab and then click on the Design verification button from the View toolbox, and the Design verification dialog appears. Design verification is used also in beams analysis, to compute beams and members stresses and strains and more.
When you add a new category, give it a name and you press add equation (criterion), press Apply button to update changes.

Add the number of equations you need by applying the same procedure as in 2.

If you want to add new categories, go to 1.

Select a category from **Project categories browser** and press the check category button to solve and get results.
Adding a category from the Beam analysis library:

**Step 1:**
Select a category from the Beam analysis library. Then press **Export category to project browser**.

**Step 2.**
Now the selected category is added to the project.
Step 3. Do the same steps (1 and 2) for the others categories if necessary

We also add new parameters by setting the new parameter in the equation left part, the operator must be set to = and in the equation right part, input the value of the new parameter (ex. Xnew = 0.4). After setting the new parameter, you can use it in a new criterion (or equation) immediately if you want (ex. \( v_{max} \leq \frac{X_{new} \cdot \text{lbridge}}{360} \)).

This equation test, in CustomDesign is written as: \( v_{max} \leq \frac{X_{new} \cdot \text{lbridge}}{360} \)

CustomDesign check the equation test and gives us the answer “success” if the test is true and “failure” if it’s false.

You can not overwrite the Primitives parameters, like the moment of inertia \( I_x \), the torsion constant \( J \), the warping torsion constant \( C_w \) and others listed initially in the list of available parameters.

In primitives parameters, we can include also the section dimensions by there labels (\( l_1, l_2, .. \)) as viewed in ShapeDesigner. The beam length is also a primitive parameter.

User can use the primitive parameters directly without setting.
To set the value \( x \) to the variable \( q_1 \), the formula is: \( q_1 = x \)
To verify if two variables \( q_1 \) and \( q_2 \) are equals, the formula is: \( q_1 =? q_2 \)
To verify if \( q_1 \) is greater or equal to \( q_2 \), the formula is: \( q_1 \geq q_2 \)
To verify if \( q_1 \) is greater than \( q_2 \), the formula is: \( q_1 > q_2 \)
To verify if \( q_1 \) is less or equal to \( q_2 \), the formula is: \( q_1 \leq q_2 \)

© MECHATOOLS TECHNOLOGIES INC. 2010
To verify if $q_1$ is less than $q_2$, the formula is: $q_1 < q_2$

**Example of member torsion**

*Important*: The equations and the cases references in the beam’s analysis library are the same referenced in the text book *Roark’s Formulas for Stress and Strain*.
Example of beam bending.

The equation formula of the selected item from the list library is:

\[ y = y_A + \theta A x + \frac{M_A x^2}{2EI} + \frac{R_A x^3}{6EI} - \frac{W}{6EI} (x - \alpha)^3 \]

And it is written in CustomDesign as:

User can view the beam analysis case by selecting the category from the list library.
For practical examples for the use of the CustomDesign component see examples section in chapter 7

Examples of plotting solution in Custom Design Component

We want plotting the solution of $u(t)$: dynamic response of simply supported beam under the effect of moving load $p=1196930$

This is the simple command to plot solution in CustomDesign:

Plot: $u(t)$,t,0,10. It means plot the solution $u$ in function of time from $t=0$ to $t=10$ sec

And finally the graphical solution $u(t)$ in Custom design

It's really very simple and easy to compute and plot complicate solutions in the efficient Component CustomDesign
Examples of plotting parametric function solution in Custom Design Component

for example we take the 2D parametric function
\[ x = t \cdot \cos(t) \]
\[ y = t \cdot \sin(t) \]

To plot the parametric function \( y(x) \), the user, input the command line: **Plot:** \( y(x), t, 0, tf \)

Where: \( tf \) is the total time.

This mean to plot the parametric function \( y \) in function of the variable \( x \) where the local variable \( t \) varies from \( t=0 \) to \( t=tf \). Example is given below in the custom design component.

The new parametric function category. It created by the user.

Plot command: **PLOT : Y(X), t, 0, t**
How to add your own Design file (equations file):

In Shape Designer the *CustomDesign* component reads the beams library from a file “CustomLibraryFilesList.CDF”. The file “CustomLibraryFilesList.CDF” contains the list of the categories that will be included in the beams library. The format of file “CustomLibraryFilesList.CDF” is:

```plaintext
COMMENT
NC Number of categories
Category name (1), category filename (1)
-----------
Category name (NC), category filename (NC)
```

The file “CustomLibraryFilesList.CDF” is saved in the “Beamslibrary” directory.

```
../ShapeDesigner/Beamslibrary/CustomLibraryFilesList.CDF
```

Each category is saved in its category filename in the directory “Beamslibrary.” Each new category will be saved in its category filename in the directory “Beamslibrary.”

*DesignFilesList.CDF* format:
For example, if you desire to add a Design Verification Code for cold formed steel so you can do it by adding new file called (for example) `coldFormedSteel2005.CDF`. And at the end of the file “DesignFilesList.CDF” add the line:

coldFormedSteel2005, coldFormedSteel2005.CDF

Do not forget to change the total number of categories to the new number one (old number of categories +1) in the second line.
CHAPTER 6

COMPONENTS AND TIPS

General Geometric Shapes

The General Geometric Shape component computes the geometric properties of predefined parametric shapes, cold formed shapes and custom free shapes. These properties are computed with respect to an arbitrary coordinate system. The shape drawing may be exported to ShapeDesigner™ or any other client applications.

Selecting a shape

To select a shape type, click on one of the predefined shapes in the General Shape, General cold formed steel or Custom Shapes tree of the Shape Type tab. Note that the Free Shape type is used to create a user-defined shape. When a shape is chosen, a detailed drawing of the chosen parametric shape is displayed. This drawing shows the customizable shape parameters.
Entering parameters

When a shape is chosen, the list of shape specific parameter with default values is displayed on the left and below the shape drawing. Parameters that do not apply to this shape are grayed out and inaccessible. Enter the shape parameters.

Specifying the coordinate system

Parametric shapes are defined with respect to a shape specific coordinate system. This coordinate system is shown in red in the detailed drawing of the chosen parametric shape. To compute geometric properties with respect to an arbitrary coordinate system, specify the orientation and position of the coordinate system using the \( \beta \), \( X_c \) and \( Y_c \) parameters.

Computing Properties

To compute properties, click Compute. The geometric properties are displayed in the Properties tab. The shape coordinates are displayed in the Data tab.

Creating User-Defined Shapes

To create a user-defined shape based on an existing parametric shape, repeat the previous steps. After clicking Compute, select the Free Shape type in the General Shape tree. Instead of having a list of shape specific parameters displayed, a tabular editing control is displayed. The cells represent the x, y coordinates of the points making up the polyline representing the shape. There are a tools bar buttons to add, insert and remove points or clear all entered data.

Note that you do not have to base a user-defined shape on an existing parametric shape. You may go directly to the Free Shape type and enter data from scratch.
Exporting the Shape

Click **Apply**, to export the shape geometry to ShapeDesigner™ (or any other application using this component).

Printing

If you want print your data, graphic shape and results in report, click Print button.

Standards Shapes

The Standards steel Shapes component displays the geometric properties of predefined **AISC, CISC** and **British** standard steel shapes. The shape drawings may be exported; using an arbitrary coordinate system, to ShapeDesigner™ or any other client applications. The General Geometric Shape component also supports multi criterion optimal shape selection.
Selecting a shape

To select a shape type, click on one of the standard shapes in the Standard Shape tree of the Shape Type tab. From the shape dropdown select the specific instance of the shape type. When an instance is selected, a detailed drawing of the chosen shape is displayed. The Properties tab contains the properties of the selected shape.

Finding an Optimal Shape

To search for a shape that satisfies a series of criteria, select the Optimization tab. From the Shapes tab, select the types of shapes you want to search. From the Constraints tab select the applicable constraints. This is done by checking one or more constraints and specifying the lower and upper value for each constraint. Click Optimize to search for the shapes. Click on the Results tab to view the properties of all shapes that satisfy the specified constraints. The valid shapes returned and selected using the shapes dropdown.
Exporting the Shape

To export the shape to ShapeDesigner™ (or any other application using this component), specify the coordinate system, transform the shape to the new coordinate system then click Apply.

Specifying the coordinate system

Standard shapes are defined with respect to a shape specific coordinate system. This coordinate system is shown in black in the detailed drawing of the chosen shape. To move the shape to a new coordinate system before exporting it, specify the orientation and position of the coordinate system using the angle $\beta$, $X_c$ and $Y_c$ parameters.

Transforming the shape to the new coordinate system

Click Compute.

Printing

If you want print your data, graphic shape and return in report, click Print button (same as the general shape component)

Shape Optimization
Optimization, give you many possibilities, the principal one is, that you can get one shape or more, by giving some constraints. Constraints can be applied to all the parameters and properties of the shape, to apply constrain to a parameter (ex. Area), you must input the upper and lower values, so the component looks for:

Lower value < Area < Upper value

and so for the other parameters. The other type of constraints is the type of shape, you must select one or more type of shapes to applied the previous parameters constraints. If all necessary constrains are applied, press the Optimize Button, to see results press the Results Tab. See figure in Finding an Optimal Shape paragraph.

Results can contain zero or many shapes that respect constrains. List of results is given in the list box, in the Results Tab. From the list box, if you select a shape, you can see the corresponding properties in the list of properties.

The other utility of the optimization feature is: if you draw or import a custom section, when you perform properties calculation, you can get the corresponding standard shape which respect some bounded dimensions and properties of the original section, this give you the possibility to replace the complicate (expensive) section with an other standard section and not expensive.

Symbolic Function

Symbolic function, is a component use ShapeDesigner™ to draw a shape or portion of shape by it’s mathematical formula. Sometimes, drawing a profile is very difficult because a complex geometry. In ShapeDesigner™ if the mathematical formula of shape is known, it very easy to draw it with symbolic component. Example below, show how to use this component simply, to draw a complex geometry.
Example:
It is a geometry of a combination of two functions, \( x = ky^2 \) and \( y = kx^2 \) \((k=1)\)

<table>
<thead>
<tr>
<th>Variables</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>+33.1630E-02</td>
</tr>
<tr>
<td>Volume</td>
<td>+33.1630E-02</td>
</tr>
<tr>
<td>Centroid Xc</td>
<td>+45.3173E-02</td>
</tr>
<tr>
<td>Centroid Yc</td>
<td>+45.2633E-02</td>
</tr>
<tr>
<td>J (Torsion Constant)</td>
<td>+89.9810E-04</td>
</tr>
<tr>
<td>Cw (Warping Constant)</td>
<td>+11.4030E-04</td>
</tr>
<tr>
<td>Xs Shear Center</td>
<td>+42.8050E-02</td>
</tr>
<tr>
<td>Ys Shear Center</td>
<td>+40.9300E-02</td>
</tr>
<tr>
<td>Neutral Angle in Deg</td>
<td>+41.0926E+00</td>
</tr>
<tr>
<td>Elastic Section Modulus Sx</td>
<td>+32.9357E-03</td>
</tr>
<tr>
<td>Elastic Section Modulus Sy</td>
<td>+32.6573E-03</td>
</tr>
<tr>
<td>Plastic Section Modulus Zpx</td>
<td>+65.0605E-03</td>
</tr>
<tr>
<td>Plastic Section Modulus Zpy</td>
<td>+64.8680E-03</td>
</tr>
<tr>
<td>Shape Coefficient X-direction</td>
<td>+19.7538E-01</td>
</tr>
<tr>
<td>Shape Coefficient Y-direction</td>
<td>+19.8633E-01</td>
</tr>
</tbody>
</table>

Results Quality

When you compute Torsion constant \( J \) and Warping constant \( Cw \), the mesh quality is important to get good results, homogeneous distribution of mesh gives very good results, see examples in chapter 7.
Utilities

From the toolbox, select Utilities tab. The utilities tab contains some utilities like, a Units converter component.

Units converter
CHAPTER 7
TECHNIQUES AND CONVENTIONS

Theoretical Background

From Vlasov’s theory the normal stresses $\sigma_z$ and torsion shear stresses are given by:

$$\sigma_z = \left(\frac{N}{A} + \frac{M_x}{I_{xx}} y_x + \frac{M_y}{I_{yy}} x_y + \frac{M_{xy}}{I} \omega^*\right)$$

$$\sigma_{xz} = G\theta \left(\frac{\partial \omega}{\partial x} - y_s\right); \quad \sigma_{yz} = G\theta \left(\frac{\partial \omega}{\partial y} - x_s\right)$$

In which $N$=normal force, $M_x$, $M_y$ =bending moment with respect to the x and y centroid axes, $M_{xy}$=bimoment, $\omega^* (x,y)$ de notes the “warping function” that represents the warping of the cross section from a plane and $x_s$, $y_s$ are the coordinates of point that lie on the centroidal axes.

The torque necessary to produce a twist $\theta$ is given by:

$$M_{xy} = G \cdot \theta \cdot J = G\theta \int_{A} \left(x_s \frac{\partial \omega}{\partial y} - y_s \frac{\partial \omega}{\partial x} + x^2 + y^2\right) dA. \text{ Or } \theta = \frac{M_{xy}}{GJ}$$

To obtain normal and shear stresses from equations given above, the following geometrical properties of cross-section must be calculated:

$$I_{xx} = \int_{A} y^2 dA; \quad I_{yy} = \int_{A} x^2 dA$$

$\omega^* (x,y)$ generalized warping function

$$\Gamma = \int_{A} \omega^2 dA$$ Principal sectorial moment of inertia, which is the famous warping constant

Sections with negligible warping stiffness cross-sections consisting of straight segments connected at a common point have negligible stiffness, $\Gamma \equiv 0$. The shear center is the common point of intersection, and the warping function vanishes at the centerline of each section.
Example of torsion

An axial load applied at the point of the beam cross section, causes additional normal stress. In this case, it is necessary to replace the force with its force-couple equivalent at the centroid C. ShapeDesigner™ performs this step.

Saint-Venant assumed that the stresses, \( \sigma_y \), \( \sigma_x \) and \( \sigma_{xy} \) are negligibly small, so that the stress tensor has the form:

\[
\begin{bmatrix}
0 & 0 & \sigma_{xz} \\
0 & 0 & \sigma_{yz} \\
\sigma_{xz} & \sigma_{yz} & \sigma_z
\end{bmatrix}
\]

The fundamental assumption in Saint-Venant’s pure torsion analysis is that the cross sections are free to warp without restraint. This assumption is not satisfied if the beam has external supports, or if the beam is not prismatic, or when the torsional moment varies along the length of the beam. Even in these cases, Saint-Venant’s hypothesis of free warping gives good approximate results for beams with solid or closed thin-walled cross sections. For open thin-walled cross sections, however, this is no longer true. The twisting resistance of such sections is so small and the axial displacements are so large that the axial stress caused by restrained warping cannot be neglected.

In pure torsion, with unrestrained warping, a reasonable approximation to the torsional shear stresses in an open thin-walled section is obtained by assuming a linear distribution across the thickness. The shear stress is then zero at the median line, and the shear flow is zero. For
restrained warping analysis, the warping constant is needed for use in the differential equation for the angle of twist. (See Beam analysis library in Custom design component for the use of this feature)

Principal Stresses

The eigenvalues of the tensor $[\sigma]$ are the principal stresses

$$\sigma_{1,3} = \frac{\sigma_z}{2} \pm \sqrt{\left(\frac{\sigma_z}{2}\right)^2 + \sigma_x^2 + \sigma_y^2}; \quad \sigma_z = 0$$

The maximum shear stress acting on the plane:

$$\tau_{\text{max}} = \frac{1}{2}(\sigma_1 - \sigma_3) = \sqrt{\frac{\sigma_z^2}{4} + \sigma_x^2 + \sigma_y^2}$$

Equivalent Von-Mises Stress

At any point of the beam cross section, the equivalent stress can be calculated directly from the stress components by

$$\sigma_{\text{von-Mises}} = \sqrt{\sigma_x^2 + 3(\sigma_x^2 + \sigma_y^2)}$$

Equivalent Tresca Stress

At any point of the beam cross section, the equivalent stress can be calculated directly from the stress components by

$$\sigma_{\text{Tresca}} = \sqrt{\sigma_x^2 + 4(\sigma_x^2 + \sigma_y^2)}$$

Note: All these stresses may be computed by ShapeDesigner™ and visualized graphically with an Isocolors (isovalue) representation in results window.

Neutral Axis

The orientation of the neutral axis in a cross section may be determined by setting $\sigma_z = 0$. Then, if $(x^*, y^*)$ are the coordinates of points that lie on the neutral axis,

$$\left(M_y/I_y\right)x^* - (M_x/I_x)y^* = 0$$

is the equation of the neutral axis in the x-y plan. Let the angles $\theta$ and $\beta$ be defined by:

$$\tan \theta = M_y/M_x, \quad \tan \beta = y^*/x^*$$
as illustrated in fig in left. That is, the moment vector is oriented at angle $\theta$ measured clockwise from the positive $x$-axis, and the neutral axis is oriented at angle $\beta$ measured clockwise from the positive $x$-axis. Then: $\tan \beta = (I_x/I_y) \tan \theta$

If you want make neutral axis parallel to the axis x, you must change applied moment’s orientation.

$$\bar{\beta} = \arctan \left( \frac{I_y}{I_x} \right) \tan \left( \theta_p \right)$$

$$\bar{\beta}_R = \theta_p + \bar{\beta}$$

Where $\theta_p$ is angle of the principal axis orientation, and $I_y, I_x$ are the principal moments of inertia about x and y axes. The applied bending moments are:

$$M_x = M$$

$$M_y = M \tan(\bar{\beta}_R)$$

Shape factor

Form window results, go to “View Toolbox” Tab and select plastic axis, it give you the position of the X plastic (neutral) axis, which cut the free area in two equals part about Y-direction, and the position of the Y-plastic (neutral) axis, which cut the free area in two equals part about X – direction. If you check on the X-Plastic Area or Y-Plastic Area in the “View Toolbox” Tab, you will get graphically the X and Y plastic Areas. This feature is used by shape designer to compute the plastic section modulus $Z_{px}$ and $Z_{py}$, with:

$$M_{y} = \sigma_{y} S$$

$M_{y}$: the Yield moment,

$S$: elastic section modulus

$$M_{y} = \sigma_{y} Z_{p}$$

$M_{y}$: the plastic moment,

$\sigma_{y}$: the Yield stress:

Where $f = M_{y}/M_{x} = Z_{p}/S$: $f$ is called the **Shape factor** each section have two factors, one in each direction $f_x$ and $f_y$.

The value of $f$ for wide flange beams is typically in the range of 1.1 to 1.2.

If the elasto-plastic curve ($\sigma, \varepsilon$) is not symmetric about x axis (ie. The positive yield strength $\sigma_y$ and the negative yield strength $\sigma_y'$ has different absolute values), we have:

$$M_{p} = \int_{A} (\sigma_{yield} \gamma) dA.$$
Where: \( y \) is measured from the plastic neutral axis. The position of the neutral plastic axis is not necessary the position which cut the free area in two equals part.

**Allowable-Stress Design**

For design purposes, we have: \( S_{\text{design}} = \frac{M_{\text{max}}}{\sigma_{\text{allow}}} \)

Shape designer gives \( S \) (elastic section modulus), if \( S \geq S_{\text{design}} \), it’s guarantee that magnitude of the flexural stress will not exceed \( \sigma_{\text{allow}} \) anywhere in the beam.

**Composite Section**

In ShapeDesigner, principally we use a non homogenous section (composite materials), after calculation we can view the transformed composite shape, by choosing a material of references, and ShapeDesigner™ shows graphically the transformed section and the corresponding geometric properties, it gives you also the stress distribution in the transformed section in additional to the stress distribution in the original section. See example in chapter 7.

**Shear stresses due to shear forces**

The shear stress due to shear force \( V \) action is given by: \( \tau_{y} = \frac{V_{y} \cdot m_{p}}{I_{y} \cdot b_{y}} \) eq. (a)

\( \tau_{y} \): average transverse shear at level \( y \) in section;
\( m_{p} \): the first moment, with respect to the neutral axis, of the cross sectional area above the level \( y \);
\( I_{y} \): moment of inertia of the entire cross section, taken with respect to the neutral axis;
\( b_{y} \): the width of the cross section at level \( y \).

The shear stress acts in the same direction as the resultant shear force \( V \).

In the \( x \) direction we use the same equations by replacing \( x \) instead of \( y \).

The reduced shear section area:
And, the section shear correction factors are given by:

\[ K_y = \frac{A_y}{A} \text{ in y direction} \]

\[ K_x = \frac{A_x}{A} \text{ in x direction} \]

The shear-stress formulas (a) may be applied to calculate the distribution of shear in a wide variety of beam shapes under a wide variety of loading. These formulas were based on the flexure formula. Therefore, the limitation on the applicability of the flexure formula (slender beam, linearly elastic behavior, etc.) apply to these shear formulas also. However, there are some additional limitations on the shape of the beam and on the load distribution. The shear stress formulas must be taken by more precaution when the width \( b_y \), varies rapidly and in thin-wall beams cases.

Shear correction factors (Timoshenko and Reissner models)

**Timoshenko** proposed a value of the factor \( k \) (\( k_x \) or \( k_y \)). He assumed that \( \tau_{sy} \) at the neutral axis NA is the same as in the simplified and in the theoretical models. In the case of the rectangular section:

at \( y=0 \) (NA) : \( \max \tau_{sy} = \frac{3V_y}{2A} \) (theoretical)

and \( \tau_{sy} (y=0) = \frac{V_y}{kA} \) (simplified beam model)

we obtain \( k = \frac{2}{3} = 0.666 \)

Theoretical model: \( \tau_{sy} = \frac{3V_y}{2A} \left(1 - \frac{4\frac{y^2}{h^2}}{1+4\frac{y^2}{h^2}}\right) \)

Mindlin without shear correction \( \tau_{sy} = \frac{V_y}{A} \)

**Reissner** assumed the equivalence between the internal energy associated to the exact distributed shear \( t \) and the deformation energy of the simplified beam model. This approach gives a value of \( k \) called the **Reissner coefficient** and in the case of the rectangular section the value of \( k \) is \( \frac{5}{6} = 0.833 \).

Flexural-torsional constant

The flexural-torsional constant \( \beta_t \) is given by:

\[ \beta_t = 1 - (x_0/r_0)^2 \]
\[ r_0^2 = r_x^2 + r_y^2 + D_{sc}^2 \]

\( r_x, r_y \): radii of gyration about centroidal principal axes

\( D_{sc} \): distance between shear center and the centroid (Dsc).

**Stability**

For thin walled beams subjected to axial forces, buckling can occur as the result of bending instability as shown in table below, or because of torsional instability. The torsional buckling loads \( P_{cr} \) for uniform shaft with axial forces passing through the shear center are given by (Pilkey 1987):

\[
P_{cr} = \frac{1}{C_p} \left( c_p \pi^2 \frac{E C_w}{L^2} + G J \right)
\]

Where:

\[
c_p = \frac{I_{gc}}{A} + \frac{e_x}{I_x} \int_A y(x^2 + y^2) \, dA + \frac{e_y}{I_y} \int_A y(x^2 + y^2) \, dA - x_0^2
\]

\( I_{gc} \): moment of inertia about centroid (\( I_{gc} + I_{gy} \)).

\( e_x, e_y \): distance in \( x,y \) direction between centroid and shear center.

<table>
<thead>
<tr>
<th>Boundary conditions</th>
<th>Bending critical load ( P_{cr} )</th>
<th>Torsional buckling load ( P_{cr} )</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Fixed-free</td>
<td>( \frac{\pi^2 E I}{4L^2} )</td>
<td>( \frac{1}{C_p} \left( \frac{\pi^2}{4L^2} \frac{E C_w}{L} + G J \right) )</td>
</tr>
<tr>
<td>2. Hinged-hinged</td>
<td>( \frac{\pi^2 E I}{L^2} )</td>
<td>( \frac{1}{C_p} \left( \frac{\pi^2}{L^2} \frac{E C_w}{L} + G J \right) )</td>
</tr>
<tr>
<td>3. Fixed-simply supported</td>
<td>( 20.19 \times \frac{E I}{L^2} )</td>
<td>( \frac{1}{C_p} \left( \frac{2.045 \times \pi^2}{L^2} \frac{E C_w}{L} + G J \right) )</td>
</tr>
<tr>
<td>4. Fixed-fixed</td>
<td>( \frac{\pi^2 E I}{4L^2} )</td>
<td>( \frac{1}{C_p} \left( \frac{4 \pi^2}{L^2} \frac{E C_w}{L} + G J \right) )</td>
</tr>
</tbody>
</table>

Stability formulas are implemented in this version of ShapeDesigner™ and user can used theme in the efficient custom design solver component.

**Shear in Built-Up Beams (Connectors calculation)**

There are a number of important applications of beams where welds, glue, rivets, bolts, or nails are used to join two or more structural components to form a single beam. Several examples of such built-up beams are used in the industry. They are:

4. a glued-laminated timber beam
5. a welded plate girder
6. a wooden box beam constructed of several planks nailed together
7. a beam with reinforcing flange plates bolted to the basic beam.

In such cases it is assumed that the beam acts as a unit (e.g., plane sections remain plane) and that the joining medium (nail, weld, bolts, etc.) is capable of transferring shear across the longitudinal junctions between component parts of the beam.

The required shear flow that must be transferred from one part of the beam to the adjacent part under the given loading condition is:

\[ n \cdot q_y = \frac{V_y \cdot m_p}{I_y} \]

where: \( n \) is the number of connectors/part and

\[ m_p = \int_A y dA \quad I_y = \int_A x^2 dA \]

For the discrete shear connectors (as bolts, discontinued weld, nails etc.), each connector having a shear-force capacity \( V_a \), are spacing along a joint at a spacing \( \Delta s \), as illustrated, then the joint will fail unless:

\[ V_a \geq q_y \cdot \Delta s \]

In ShapeDesigner, you can verify your design: In the Results mode window select the Design tab and then click on the Shear Flow-Built-up button from the View toolbox, and the Shear Flow in Built-up Beams dialog appears.
The local Shear Flow case
The composite action Shear Flow case
The continued welded bead case

[Diagram of continued weld bead connectors]
Example of steel-concrete composite section in ShapeDesigner:

For practical examples for the use of the Shear flow built-up component see examples section in chapter 7

How to avoid torsion?*

a. Add stiffeners
b. Change cross section so that the load acts through the shear center
c. Use hollow sections

* Strength and stability of aluminium members according to EN 1999-1-1 – Eurocode 9 Torsten Höglund Royal Institute of Technology Stockholm
Report Problems or Errors

To report problems or errors, please record the exact steps that lead up to the problem so that we may reproduce the condition. Email or fax these steps to our technical support. Any additional information that may be relevant to locating or verifying the problem is appreciated.
EXAMPLES

Computing J and Cw

Computing of the twist angle

Torsion of Thin-wall I section member

A small cantilever beam, with left end free to twist and warp right end fixed (no twist or warp). select Case 1b_tosion in custom design solver component

Filename: roarks-p392-ex2.SHD

Data:
l=240 in, T=18 000 lb-in; a=144 in, E=30.10^6 lb/in^2; G =12.10^6 lb/in^2.

<table>
<thead>
<tr>
<th></th>
<th>Constant J</th>
<th>Warping Cw</th>
<th>(\theta_0)</th>
<th>Ix</th>
<th>Yc</th>
</tr>
</thead>
<tbody>
<tr>
<td>ShapeDesigner</td>
<td>0.207 in^4</td>
<td>142.4 in^6</td>
<td>0.3999</td>
<td>107.3 in^4</td>
<td>4.228 in</td>
</tr>
<tr>
<td>Reference</td>
<td>0.198 in^4</td>
<td>142.2 in^6</td>
<td>0.43953</td>
<td>107.3 in^4</td>
<td>4.228 in</td>
</tr>
</tbody>
</table>
Composite section

Composite Section

Filename: Alumin-Wood-5-23-new.SHD

The composite section shown in Figure at left is used as simply supported beam. If the maximum bending moment in the beam is 216,000 in.-lb, determine the stress distribution in the aluminum and in the wood. The elastic moduli for aluminum and wood are $10 \times 10^6$ psi and $1.25 \times 10^6$ psi, respectively.

<table>
<thead>
<tr>
<th>Property</th>
<th>X-Y axes</th>
<th>Analytical</th>
<th>Centroid axes</th>
<th>Analytical</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I_x$</td>
<td>+1057.33</td>
<td>1057 in$^3$</td>
<td>+216.333 in$^2$</td>
<td>216 in$^2$</td>
</tr>
<tr>
<td>$I_y$</td>
<td>+469.333</td>
<td>460 in$^2$</td>
<td>+69.3333 in$^2$</td>
<td>69 in$^2$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Properties</th>
<th>Computed Value</th>
<th>Analytic value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>+16.0000E+00</td>
<td>16 in$^2$</td>
</tr>
<tr>
<td>CArea</td>
<td>+10.0000E+01</td>
<td>100 in$^2$</td>
</tr>
<tr>
<td>Centroid Xc</td>
<td>+20.0000E-01</td>
<td>2 in</td>
</tr>
<tr>
<td>Centroid Yc</td>
<td>+29.0000E-01</td>
<td>2.9 in</td>
</tr>
<tr>
<td>J (Torsion Constant)</td>
<td>+17.6430E+00</td>
<td>-</td>
</tr>
<tr>
<td>Cw (Warping Constant)</td>
<td>+20.9620E-01</td>
<td>-</td>
</tr>
<tr>
<td>Xs Shear Center</td>
<td>+20.0070E+01</td>
<td>-</td>
</tr>
</tbody>
</table>
All these results, including the stresses results are obtained directly from shape designer, note that in shape designer you can compute stress in any position by just click the mouse at the position in drawing view (or input exact values (x, y) from key board) and the results are update.

The figure shown, gives the bending stress distribution in the composite section.

Axial Stress Distribution (bending moment Effects)

You can get the stress distribution, align axis perpendicular to the neutral axis, in Shape designer stress distribution is given dynamically, you just move a mouse over the section and select the position of the axis that you want see the stress distribution. The axis move also dynamically. So
you can get the stress distribution in any position of the section dynamically. This is applicable for the original and transformed composite sections. The stress distribution is about the action of the bending moments $M_x$ and $M_y$.

**Residual Stresses**

If the applied moment is reduced after exceeding the yield moment $M_y$, unloading takes place along a moment-curvature path that is parallel to the original linear portion of the moment-curvature diagram. Therefore, we can use the superposition procedure of adding the elastic-recovery stresses to the stresses due to plastic loading.

**Shear Stresses**

**Rectangular section**

Compute the shear stresses due to the vertical shear force $V_y=1.0 \text{ lb}$

Analytical solution: 

$$\tau_{y} = \frac{V_y \cdot m_y}{I_y \cdot b}$$

$\tau_{y}$: average transverse shear at level $y$ in section;

$m_y$: the first moment, with respect to the neutral axis, of the the cross sectional area above the level $y$;

$I_y$: moment of inertia of the entire cross section, taken with respect to the neutral axis;

$b_y$: the width of the cross section at level $y$.

$$\tau_{y} = \frac{12V_y \cdot b(h^2 - 4y^2)}{8 \cdot b^3} = \frac{3V_y}{2A} \left(1 - \frac{4y^2}{h^2}\right)$$

$$\text{Max} \tau_{y} = \frac{3 \cdot V_y}{2 \cdot A} = 3.0 \times 10^{-4} \text{ psi}$$


**Filename:** cote-p562-shear-rectangular.shd

ShapeDesigner results:
Circular section

Filename: Shear-circle.SHD
Compute the shear stresses due to the vertical shear force $V_y = 1.0$ lb.

\[
\tau_y = \frac{64 V_y}{\pi D^2} \left(\frac{D^2 - 4 y^2}{12 \sqrt{D^2 - 4 y^2}}\right) = \frac{4 V_y}{3 A} (1 - \frac{y^2}{D^2})
\]

Max $\tau_y = \frac{4 - V_y}{3 - A} = 4.2441 \times 10^3$ psi

Rectangular section with holes

Compute the shear stresses due to the vertical shear force $V_y = 60$ KN.

We have the rectangular section (200 mm x 600 mm), with two square holes (100 mm x 100 mm).

Compute the maximum shear stresses due to the vertical shear force $V_y = 60$ KN.

$I_y = 3133 \times 10^6 \text{ mm}^4$

At $y = 100$ mm, $\tau_y = \frac{60000 \times 65.10^6}{3133.10^6 \times 100} = 1245 KPa = \text{Max } \tau_y$
At \( y = 0 \) mm, \( \tau = \frac{60000 \cdot 7.5 \times 10^6}{3133 \times 10^6 \cdot 200} = 718 \text{KPa} \)

**Filename**: cote-p564-shear-2holes.shd

ShapeDesigner™ results:

- **Stresses at \( y = 0 \) (from centroid)**
- **maximum stresses**
Composite rectangular section

Compute the shear stresses due to the vertical shear force $V_Y=20$ KN. We consider a composite wood beam section, see figure (dimensions [mm]).

If we take the material $E_1$ as material of reference, we have:

$$n_2 = \frac{E_2}{E_1} = 1.5 \text{ and } I_0 = I_{x1} + n_2 I_{x2}$$

Max $\tau_{y_1} \text{ (glue) } = \max \tau_{y_1 \text{ (y=90)}} = 552 \text{ kPa}$

Max $\tau_{y_1} \text{ (wood } E_1) = \max \tau_{y_1 \text{ (y=0)}} = 759 \text{ kPa}$

Filename: cote-p574-Shear-3materials.SHD
Shear Stresses and bimoment effect

I section

The “I” beam shown in the figure is subjected to a concentrated load of 40 000 lb, which is eccentric by 1 in from the vertical plane of the web. The flanges are 10 in by 0.5 in and the web is 12 in (Ref. Pilkey 1978). The ends experience no rotation, but are free to warp (case \textsc{le\_torsion} in \textsc{CustomDesign} component see chapter 5). Determine the maximum normal and Shear stresses.

The Beam length is $l=200$ in, $E=3 \times 10^7$ lb/in$^2$, poison ration $\nu=0.3$

Reference results:

$C_w=3000$ in$^6$

$I=432$ in$^4$

$J=1.333$ in$^4$

Bimoment $B(x=l/2)=1321200$ lb.in$^2$

Warping torque $T_w(x=l/2)=20000$lb.in

The normal stress due to warping at the right edge of the top flange:

$\sigma_w=\frac{B*\omega}{c_w}=-13212$ lb/in$^2$

The usual bending stress is found from a bending moment at midspan of $M=Pl/4 = 2000000$lb.in

$\sigma_x = 2000000 \times \frac{6}{432}$ lb/in$^2 = 27.78 \times 10^3$ lb/in$^2$

And the total axial stresses (at left and right top flange) is $\sigma_x = 40990$ lb/in$^2$ or 14566 lb/in$^2$

Page 172, example 5.1.

Filename: Pilkey172.shd
ShapeDesigner™ results
And the total axial stresses $\sigma_x + \sigma_0$
To compute internal force $B_\omega$ and warping torque we select *Design verification* button to get the design Verification solver component: We select the $1e_torsion$ case (both ends free to warp but not twist).
For example at x=l/2:

Bimoment $B_w(\text{computed}) = 129.0 \times 10^4 \text{ lb.in}^2$

Bimoment $B_w(\text{ref}) = 132.12 \times 10^4 \text{ lb.in}^2$

$C_w(\text{computed}) = 299.08 \text{ in}^3$

$C_w(\text{ref}) = 300 \text{ in}^3$

$J(\text{computed}) = 1.43 \text{ in}^4$

$J(\text{ref}) = 1.333 \text{ in}^4$

Torque = warping torque (computed) = -20,000 lb.in

Torque = warping torque (ref.) = -20,000 lb.in
Shear Flow in Built-Up Beams and connectors calculation

Box wood section

A box beam is made by nailing together four boards as in the illustrated configuration. The beam supports a concentrated load of 1000 lb at its midspan, the beam is simply supported. If each nail can withstand an allowable shear force of 150 lb, what is the maximum spacing $\Delta s$ that can be used?

Filename Graig_p325.SHD

To compute the result shear $V$, after calculation of the geometric properties in ShapeDesigner select the CustomDesign component as described above and select the corresponding category (simply supported beam). Set the applied load to 1000lb and press the check category button to extract the results.
Here is the plotted distributed shear resultant \( V(x) \) along the beam. The obtained result is \( V=500 \text{ lb} \)
Mixed Section: Steel-Concrete

A composite beam is made up of a stab concrete slab pinned to a steel I shape. If the shear force $V_y$ is 325KN and each connector can withstand an allowable shear capacity of 45KN, what is the maximum spacing that can be used $\Delta_s$? Given is Elastic modulus: $E_{\text{steel}} = 8 \times E_{\text{concrete}}$

Filename: Cote-Bult-Up-575.SHD
The given values and the result obtained by ShapeDesigner:
Given shear \( V \)

Given Connector capacity

Given Number of connectors

Connectors spacing in this case we can take \( \Delta s = 300 \text{ mm} \)
Moment capacity of a composite beam (BS 5950)

Determine the moment capacity of the section shown in Fig. 4.46 assuming the UB is of grade S275 steel and the characteristic strength of the concrete is 35 N/mm².

Filename: design-elements ex4.17-p209.SHD
Output report file (to printer or PDF file)
### Section Geometric Properties and Stresses Analysis Results

<table>
<thead>
<tr>
<th>Area X-Y</th>
<th>Centroidal Axes</th>
<th>Principal Axes</th>
<th>Elastic Neutral Axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ix (mm^4)</td>
<td>+30.37E+05</td>
<td>+30.37E+05</td>
<td>+30.37E+05</td>
</tr>
<tr>
<td>Iy (mm^4)</td>
<td>+19.95E+05</td>
<td>+19.95E+05</td>
<td>+19.95E+05</td>
</tr>
<tr>
<td>Ixy (mm^4)</td>
<td>+11.93E+05</td>
<td>+11.93E+05</td>
<td>+11.93E+05</td>
</tr>
<tr>
<td>Is (mm^4)</td>
<td>+45.87E+05</td>
<td>+45.87E+05</td>
<td>+45.87E+05</td>
</tr>
<tr>
<td>nx (mm)</td>
<td>+36.83E+00</td>
<td>+36.83E+00</td>
<td>+36.83E+00</td>
</tr>
<tr>
<td>ny (mm)</td>
<td>+36.83E+00</td>
<td>+36.83E+00</td>
<td>+36.83E+00</td>
</tr>
<tr>
<td>nx (mm^3)</td>
<td>+42.56E+00</td>
<td>+42.56E+00</td>
<td>+42.56E+00</td>
</tr>
<tr>
<td>nxy (mm^3)</td>
<td>+23.55E+00</td>
<td>+23.55E+00</td>
<td>+23.55E+00</td>
</tr>
<tr>
<td>n (mm)</td>
<td>+48.63E+00</td>
<td>+48.63E+00</td>
<td>+48.63E+00</td>
</tr>
<tr>
<td>Y top (mm)</td>
<td>+47.99E+00</td>
<td>+47.99E+00</td>
<td>+47.99E+00</td>
</tr>
<tr>
<td>Y bot (mm)</td>
<td>+45.87E+00</td>
<td>+45.87E+00</td>
<td>+45.87E+00</td>
</tr>
<tr>
<td>X top (mm)</td>
<td>+47.99E+00</td>
<td>+47.99E+00</td>
<td>+47.99E+00</td>
</tr>
<tr>
<td>X bot (mm)</td>
<td>+45.87E+00</td>
<td>+45.87E+00</td>
<td>+45.87E+00</td>
</tr>
<tr>
<td>X (mm)</td>
<td>+73.14E+00</td>
<td>+73.14E+00</td>
<td>+73.14E+00</td>
</tr>
<tr>
<td>Y (mm)</td>
<td>+73.14E+00</td>
<td>+73.14E+00</td>
<td>+73.14E+00</td>
</tr>
<tr>
<td>Zp (mm)</td>
<td>+47.99E+00</td>
<td>+47.99E+00</td>
<td>+47.99E+00</td>
</tr>
<tr>
<td>Zp (mm)</td>
<td>+47.99E+00</td>
<td>+47.99E+00</td>
<td>+47.99E+00</td>
</tr>
<tr>
<td>Max Mx (N-mm)</td>
<td>+65.95E+00</td>
<td>+65.95E+00</td>
<td>+65.95E+00</td>
</tr>
<tr>
<td>Max My (N-mm)</td>
<td>+65.95E+00</td>
<td>+65.95E+00</td>
<td>+65.95E+00</td>
</tr>
<tr>
<td>Max Mn (N-mm)</td>
<td>+65.95E+00</td>
<td>+65.95E+00</td>
<td>+65.95E+00</td>
</tr>
</tbody>
</table>

### Composite Section

<table>
<thead>
<tr>
<th>1. User-Defined</th>
<th>+48.83E+00</th>
<th>+48.83E+00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ycc</td>
<td>+13.54E+00</td>
<td>+13.54E+00</td>
</tr>
<tr>
<td>Zcc</td>
<td>+13.54E+00</td>
<td>+13.54E+00</td>
</tr>
</tbody>
</table>

### Stresses

<table>
<thead>
<tr>
<th>Yield &amp; Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sy</td>
</tr>
<tr>
<td>Syy</td>
</tr>
<tr>
<td>Tau</td>
</tr>
<tr>
<td>Syy</td>
</tr>
<tr>
<td>Sxx</td>
</tr>
<tr>
<td>Gxx</td>
</tr>
<tr>
<td>Gyy</td>
</tr>
<tr>
<td>Nxx</td>
</tr>
<tr>
<td>Nyy</td>
</tr>
</tbody>
</table>

### Loads

<table>
<thead>
<tr>
<th>Load Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moment Mx</td>
<td>+20.21E+02 N-mm</td>
</tr>
<tr>
<td>Moment My</td>
<td>+10.00E+00 N-mm</td>
</tr>
<tr>
<td>Axial N</td>
<td>+10.00E+00 N-mm</td>
</tr>
<tr>
<td>Torque Tz</td>
<td>+42.44E+06 N-mm</td>
</tr>
<tr>
<td>Bending Moment Bw</td>
<td>+10.00E+00 N-mm²</td>
</tr>
<tr>
<td>Shear Vy</td>
<td>+26.31E+06 N</td>
</tr>
<tr>
<td>Shear Vx</td>
<td>+19.42E+05 N</td>
</tr>
</tbody>
</table>
The ShapeDesigner™ input file is a common ASCII file with extension ".SHD". It's structure is simple and intuitive. An example is given below: word in bold is a shape designer keyword you cannot change any keyword.
<table>
<thead>
<tr>
<th>Project</th>
<th>Your Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Your Task</td>
</tr>
</tbody>
</table>

**Engineer**

- **Zoom:** 1.5
- **XMAX:** 12.3577
- **XMIN:** -0.975609
- **YMAX:** 11.5447
- **YMIN:** -1.78861

**Coordinates**

- Number of coordinates: 8
- \( x \): -32.52607E-17
- \( y \): -13.32268E-16

**Shapes**

- Number of shapes: 1
- Shape number 1

**Holes**

- Number of holes: 0

**Color**

- Color: 16711680

**Thickness**

- Mass area: 10.00000E-01

**Elastic Module**

- 100000

**Positive Yield Strength**

- 300000

**Negative Yield Strength**

- -300000

**Poisson Coefficient**

- 0.27

**Cotations**

- Number of cotations: 5

**Cotation**

- Cotation 1

**Delta X**

- DeltaX: 6.2522842035061

**Delta Y**

- DeltaY: 10.639853872904

**Orientation**

- Orientation 1
LENGTH UNIT
2 Centimeter

MASS UNIT
1 Kilogram

STRESS UNIT
1 Kg/cm²

MOMENT MX
10

MOMENT MY
15

SHEAR VX
0

SHEAR VY
0

BIMOMENT MW
0

WRAPING TORQUE TW
0

TORQUE T
0

NORMAL LOAD NX
0

0

END
Output File

The shape designer tabulated results Output file, is a commonly ASCII file with extension ".OUT". Its structure is simple. An example is given below. You can get also graphical results by choosing print from toolbar in the current activate window.

```
M E C H A T O O L S  S T U D I O

******************************************************************************
*          SHAPE DESIGNER 2010.0       *
*                                      *
*  SECTIONAL PROPERTIES CALCULATION  *
* AND DESIGN OF SOLID AND THIN-WALLED *
* BEAM SECTIONS                       *
* MECHATOOLS TECHNOLOGIES® 2010       *
******************************************************************************

Identification Project:
******************************************************************************
Name Project Information
******************************************************************************
Version: ShapeDesigner 2010.0
Date: 10:02:26/07-05-2010
Engineer: PROJECT
Project: Your Project
Comment: Your Task
Units:
Length: cm
Mass: kg
Stress: kg/cm^2
******************************************************************************

Original System Axes:
******************************************************************************
Properties Values
******************************************************************************
Axes X-Y
Ix (in^4) +13.021E+05
Iy (in^4) +59.387E+04
Ixy (in^4) +54.142E+04
Io (in^4) +18.96E+05
rx (in) +48.459E+00
ry (in) +32.726E+00
ro (in) +58.474E+00
Theta (Deg) +00.0E+00

Centroidal Axes
Ix (in^4) +80.794E+04
Iy (in^4) +24.213E+03
Ixy (in^4) +10.824E+03
Io (in^4) +83.215E+04
rx (in) +38.171E+00
ry (in) +66.079E-01
ro (in) +38.739E+00
Theta (Deg) +00.0E+00

Principal Axes
Ix (in^4) +80.809E+04
Iy (in^4) +24.063E+03
Ixy (in^4) +83.215E+04
rx (in) +38.174E+00
ry (in) +65.875E-01
ro (in) +38.739E+00
IMax (in^4) +80.809E+04
IMin (in^4) +24.063E+03
Theta (Deg) -79.108E-02
******************************************************************************

Custom System Axes - at Position:(0,0)
******************************************************************************
Properties Values
******************************************************************************
```
Custom Axes
IX (in^4)  +00.0E+00
Iy (in^4)  +00.0E+00
Ixy (in^4) +00.0E+00
IO (in^4)  +00.0E+00
rx (in)    +00.0E+00
ry (in)    +00.0E+00
rO (in)    +00.0E+00
Theta (Deg) +00.0E+00

Principal Axes
IX (in^4)  +00.0E+00
Iy (in^4)  +00.0E+00
Ixy (in^4) +00.0E+00
IO (in^4)  +00.0E+00
rx (in)    +00.0E+00
ry (in)    +00.0E+00
rO (in)    +00.0E+00
IMax (in^4) +00.0E+00
IMin (in^4) +00.0E+00
Theta (Deg) +00.0E+00

General and Constants Results:

Variables              Values

Area                   +55.452E+01 in^2
Mass                   +55.452E+01 lb
Volume                 +55.452E+01 in^3
TArea                  +55.452E+01 in^2
TVolume                +55.452E+01 in^3
Xc                      +32.052E+00 in
Yc                      +29.854E+00 in
J(Torsion)             +32.634E+02 in^4
Cw(Warping)            +43.840E+06 in^6
Xs (Shear)             +19.133E+00 in
Ys (Shear)             +11.184E+00 in
Swx                     -31.221E+04 in^5
Swy                     +10.236E+06 in^5
NA (Deg)               +24.086 Deg
PNA (x,y):              (+31.831,+30.348)
SX Top                 +12.885E+03 in^3
Sx bottom              +11.689E+03 in^3
Sy Top                 +41.422E+02 in^3
Sy bottom              +56.486E+02 in^3
Zpx                     +17.258E+03 in^3
Zpy                     +76.414E+02 in^3
SFx                     +1.479
SFy                     +1.845
Sigma yield+           +10.0E-01 lb-in
Sigma yield-           -10.0E-01 lb-in
Fully Mpx              +17.258E+03 lb-in
Fully Mpy              +76.414E+02 lb-in
Mx yield               +11.689E+03 lb-in
My yield               +41.422E+02 lb-in
Ax                      +38.522E+01 in^2
Kx                       +0.695
Ay                      +35.849E+01 in^2
Ky                       +0.646
Bx(Stability)          +26.673E+05 in^5
By(Stability)          +45.535E+05 in^5

By MechaTools Technologies (c) 2010 End
The following references were consulted in the development of Shape Designer. You may find them useful for theoretical background, and basics calculating properties, verifying Shape Designer's results, etc.


